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About this book

Document description

This installation guide provides information on how to install and configure
IBM® WebSphere® Commerce Studio Business Developer Edition and IBM
WebSphere Commerce Studio Professional Developer Edition. It is intended
for developers or system administrators who are using WebSphere Commerce
Studio to develop store-front assets and back-office business logic to run with
WebSphere Commerce.

Updates to this book

To learn about last-minute changes to the product, refer to the README file
in the root directory of the WebSphere Commerce Studio CD 1. In addition, a
copy of this book, and any updated versions of this book, are available as
PDF files from the Technical Library section of the WebSphere Commerce Web
site:

[http://www.ibm.com/software/commerce/library/|

For additional support information, see the WebSphere Commerce Support
site:

[http://www.ibm.com/software/commerce/support/|

Updated versions of this book are also available from the WebSphere
Commerce Zone at WebSphere Developer Domain which is at the following
Web site:

[rttp://www.ibm.com/websphere/developer/zones/commerce|

Updates from the last version of this document are identified by revision
characters contained in the margin. This book uses the following conventions
for revision characters:

* The "+" character identifies updates that have been made in the current
version of this document.

¢ The "1" character identifies any updates that have been made in the
previous versions of this document.
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Conventions and terminology used in this book
This book uses the following highlighting conventions:

Boldface type Indicates commands or graphical user interface (GUI) controls
such as names of fields, icons, or menu choices.

Monospace type Indicates examples of text you enter exactly as shown, file
names, and directory paths and names.

Italic type Used to emphasize words. Italics also indicate names for which
you must substitute the appropriate values for your system.

host_name The fully qualified host name of your WebSphere Commerce
Studio server (for example, serverl.torolab.ibm.com is fully
qualified).

instance_name The name of the WebSphere Commerce Studio instance with

which you are working.

This icon marks a Tip - additional information that can help you
complete a task.

— Important
These sections highlight especially important information.

— Attention
These sections highlight information intended to protect your data.

b Business | Indicates information specific to WebSphere Commerce Studio, Business
Developer Edition.

Indicates information specific to WebSphere Commerce Studio, Professional
Developer Edition.

Indicates information specific to DB2 Universal Database™.
Note: All references to DB2 Universal Database in this book refer to DB2
Universal Database Enterprise Server Edition.

BT Indicates information specific to Oracle9i Database.

This book uses the following terms:
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back-office business logic
The part of your store that customers do not see. Back-office business
logic includes WebSphere Commerce commands, data beans,
enterprise beans

development machine
The machine onto which you install WebSphere Commerce Studio to
develop store-front assets or back-office business logic for WebSphere
Commerece.

store data
The information for a store that supports all customer activities. Store
data includes catalog information, shipping charge information, and
inventory information.

store-front assets
The part of your store with which your customers interact. Store-front
assets include HTML pages, JSP files, style sheets, images, graphics,
and other multimedia file types that define the layout and content of
your Web pages.

Path variables
This guide uses the following variables to represent directory paths:

DB2_installdir
This is the installation directory for DB2 Universal Database. The
default installation directory for DB2 Universal Database installed by
the WebSphere Commerce Studio installation wizard is
C:\WebSphere\SQLLIB.

WCStudio_installdir
This is the installation directory for WebSphere Commerce Studio. The
default installation directory for WebSphere Commerce Studio is
C:\WebSphere\CommerceStudiob5.

WCStudio_workspacedir
This is the directory for the WebSphere Commerce Studio workspace.
The default workspace directories are as follows:

W73 C:\WebSphere\workspace_db2

C:\WebSphere\workspace_oracle

WSAD_installdir
This is the installation directory for WebSphere Studio Application
Developer. The default installation directory for WebSphere Studio
Application Developer is C:\WebSphere\Studio5.
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Knowledge requirements

vi

This book should be read by developers or system administrators who are
installing WebSphere Commerce Studio to develop store-front assets and
back-office business logic to run with WebSphere Commerce.

Developers or system administrators who are installing and configuring
WebSphere Commerce Studio should have knowledge in the following areas:

» Microsoft® Windows® 2000 Server Edition or Advanced Server Edition
¢ IBM DB2 Universal Database or Oracle database
* Basic SQL commands

This knowledge should include how to complete administration and
configuration tasks for the operating system and database server.

Developers who are developing store-front assets or back-office business logic
with WebSphere Commerce Studio should have knowledge in the following
areas:

* IBM WebSphere Commerce

* IBM WebSphere Studio Application Developer

* IBM DB2 Universal Database or Oracle database
* Java ' programming language

* Enterprise JavaBeans = component architecture

* JavaServer Pages technology

+ HTML

* XML
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Part 1. Introduction

The chapters in this section give a basic description of WebSphere Commerce
Studio, and describe the prerequisite hardware, software, and user authorities
required to complete a successful installation of WebSphere Commerce Studio.
Ensuring that your system meets all the requirements stated in these chapters
will significantly improve the ease with which your installation is completed.
Read this section thoroughly before attempting to install WebSphere
Commerce Studio.

To learn about last-minute changes to the product, refer to the README file in
the root directory of the WebSphere Commerce Studio CD.

Important
If you are upgrading from a previous version of WebSphere Commerce
Studio, please read the WebSphere Commerce Studio Migration Guide before
performing the upgrade.
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Chapter 1. Welcome to WebSphere Commerce Studio

The WebSphere Commerce Studio product contains the WebSphere Commerce
Studio, Version 5.5 CDs and the WebSphere Commerce, Version 5.5 CDs.
WebSphere Commerce Studio and WebSphere Commerce are generally
installed on separate machines.

This book describes how to install and configure WebSphere Commerce
Studio Professional Developer Edition, and WebSphere Commerce Studio
Business Developer Edition for Windows 2000. It is intended for developers or
system administrators who are using Commerce Studio to develop stores and
WebSphere Commerce application code.

AN If you are using WebSphere Commerce Studio Business Developer
Edition to create customized Java code, it can only be deployed to a
WebSphere Commerce Business Edition application.

If you are using WebSphere Commerce Studio Professional
Developer Edition to create customized Java code, it can only be deployed to
a WebSphere Commerce Professional Edition application.

For instructions on the installation and configuration of WebSphere
Commerce, refer to WebSphere Commerce Installation Guide for Windows 2000

Products included with WebSphere Commerce Studio

The following products and components are packaged with WebSphere
Commerce Studio:

* WebSphere Studio Application Developer, Version 5.0, with the following
plug-ins and toolkits:

— WebSphere Commerce workspace for WebSphere Studio

— WebSphere Commerce Configuration Manager plug-in for WebSphere
Studio

— WebSphere Commerce online help plug-in for WebSphere Studio

— WebSphere Commerce API reference information plug-in for WebSphere
Studio

WebSphere Studio Application Developer also includes an integrated

WebSphere test environment.

* IBM DB2 Universal Database Enterprise Server Edition Version 8.1.1 (DB2
Universal Database Version 8.1 with FixPak 1)

© Copyright IBM Corp. 1996, 2003 3



Note: All references to DB2 Universal Database in this book refer to DB2
Universal Database Enterprise Server Edition.

e IBM DB2 Universal Database Administration Client, Version 8.1.1

* WebSphere Commerce, Version 5.5
WebSphere Commerce for Windows is included with WebSphere Commerce
Studio for testing purposes. If you want to put your site into production
using WebSphere Commerce, you must purchase a licensed copy of
WebSphere Commerce.

For a list of products available for testing purposes included with
WebSphere Commerce, refer to WebSphere Commerce Installation Guide.

Oracle9i Database Release 2 is supported as a WebSphere Commerce Studio
database, but Oracle9i Database is not included with WebSphere Commerce
Studio.

Supported configurations

WebSphere Commerce Studio, its components and its supported software can
be installed in a variety of configurations. The following configurations are
supported and are covered in this book:

* ["WebSphere Commerce Studio using a local database”]

+ ["WebSphere Commerce Studio using a remote database”]

* ["WebSphere Commerce and WebSphere Commerce Studio” on page 5|

* ["WebSphere Commerce Payments and WebSphere Commerce Studio” on|
page 5|
WebSphere Commerce Studio using a local database

In this configuration, WebSphere Commerce Studio and the WebSphere
Commerce Studio database are installed on the same machine.

DB2 Universal Database or Oracle9i Database can be used as the WebSphere
Commerce Studio database.

WebSphere Commerce Studio using a remote database

In this configuration, WebSphere Commerce Studio and the WebSphere
Commerce Studio database are installed on separate machines. This
configuration requires you to install a database client on the machine on
which you install WebSphere Commerce Studio and the database server on
the remote machine.

DB2 Universal Database or Oracle9i Database can be used as the WebSphere
Commerce Studio database.
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WebSphere Commerce Studio only supports remote databases running on
Windows.

WebSphere Commerce and WebSphere Commerce Studio

WebSphere Commerce Studio and WebSphere Commerce can be installed on
the same system with some restrictions. Refer to [“WebSphere Commerce]
[Studio and WebSphere Commerce coexistence” on page 96| for more
information.

WebSphere Commerce Payments and WebSphere Commerce Studio

WebSphere Commerce Payments can run on the same machine as WebSphere
Commerce Studio or a separate machine regardless of where the WebSphere
Commerce Studio database is located.

For more information on WebSphere Commerce Payments and WebSphere
Commerce Studio, refer to [Chapter 13, “Configuring payment processing in|
[WebSphere Commerce Studio,” on page 53]

Chapter 1. Welcome to WebSphere Commerce Studio 5
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Chapter 2. Planning your WebSphere Commerce Studio
installation

Developing for an AIX®, Linux, Solaris Operating Environment, or Windows DB2
Universal Database production environment
For development targeting a production environment running DB2 Universal

Database on AIX, Linux, Solaris Operating Environment, or Windows, you
must use DB2 Universal Database running on Windows.

Developing on Oracle9i Database for deployment to DB2 Universal Database
is not supported.

Database management systems running on operating systems other than
Windows are not supported by WebSphere Commerce Studio.

Developing for an OS/400® DB2 Universal Database production environment

If you are developing code for an OS/400 DB2 Universal Database production
environment, you should plan to develop and test against DB2 Universal
Database running on Windows. When you are ready to deploy your code to
the iSeries' environment, use the WebSphere Commerce EJB conversion tool
to convert EJB meta-data from the workstation flavor of DB2 Universal
Database to the iSeries flavor.

More information about deploying code to a production environment is
provided in WebSphere Commerce Programming Guide and Tutorials.

Developing for an Oracle9i Database production environment

If you are developing for an Oracle9i Database production environment for
WebSphere Commerce, you can develop on DB2 Universal Database running
on Windows or Oracle9i Database running on Windows.

If you use DB2 Universal Database to develop for a Oracle9i Database
environment, you must use the WebSphere Commerce EJB conversion tool to
convert EJB meta-data from DB2 Universal Database to Oracle9i Database.
Refer to WebSphere Commerce Programming Guide and Tutorials for more
information.

Oracle9i Database running on operating systems other than Windows is not
supported by WebSphere Commerce Studio.

© Copyright IBM Corp. 1996, 2003 7
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Chapter 3. Before you install WebSphere Commerce Studio

Before you install WebSphere Commerce Studio, do the following:

1. Ensure that your machine meets the pre-installation requirements listed in
[‘Pre-installation requirements.”|

2. Gather the information required to complete the WebSphere Commerce
Studio installation wizard. Refer to[Chapter 4, “Quick reference to user IDs|
fand other information,” on page 13|

3. Stop any applications running on your machine. You will need to restart
your machine during the installation process, which can cause running
applications to lose data.

Pre-installation requirements

Before installing WebSphere Commerce Studio, ensure that your machine
meets the following hardware and software prerequisites.

Prerequisite hardware

In addition to the requirements for the installation of WebSphere Commerce,
you must ensure that you meet the following minimum hardware
requirements before installing WebSphere Commerce Studio:

* You require a dedicated Pentium® III 733 MHz IBM-compatible personal
computer with the following:

— A minimum of 1 GB of random access memory (RAM).
— 4.23 GB of hard drive space broken down as follows:

- 1.25 GB of temporary hard drive space required on the C: drive during
the installation. This temporary hard drive space can be broken down
as follows:

¢ 950 MB of temporary hard drive space required for installing
WebSphere Studio Application Developer.

* 300 MB of temporary hard drive space required for installing
WebSphere Studio Application Developer fixes.

These fixes do not include the fixes documented in Kihapter 9,|
["Mandatory post-installation tasks,” on page 39

If 1.25 GB of temporary hard drive space is not available, you can
reduce the free space requirements by following the instructions in
Chapter 12, “Installing WebSphere Commerce Studio on systems with|
less than 1 GB of temporary hard drive space,” on page 49 After

© Copyright IBM Corp. 1996, 2003 9



+ + 4+ o+ 4

+ 4+ +

completing these instructions, the temporary hard drive space
requirements are reduced to 300 MB.

- WebSphere Commerce Studio: 740 MB
- WebSphere Studio Application Developer: 870 MB
- WebSphere Commerce Workspace: 500 MB

- B DB?2 Universal Database: 870 MB

Using a remote DB2 Universal Database removes this space
requirement from the WebSphere Commerce Studio machine.

- BIZTM For Oracle9i Database hard drive space requirements, refer to
the Oracle9i Database documentation.

— A CD-ROM drive.

— A graphics-capable monitor with a color depth of at least 256 colors,
with screen resolution set to 800x600 or higher.

— A mouse or other pointing device.

— Alocal area network (LAN) adapter that is supported by the TCP/IP
protocol.

Prerequisite software

You must ensure that you meet the following minimum software requirements
before installing WebSphere Commerce Studio:

* Ensure that you have Windows 2000 Professional Edition, Server Edition, or
Advanced Server Edition installed with Service Pack 3 applied.

* Install Microsoft Internet Explorer 6.0 Service Pack 1 or higher with the
latest critical security updates, on the machine(s) you will use to access
WebSphere Commerce Studio. Internet Explorer is available as a download
from Microsoft at the following Web site:

[http://www.microsoft.con

Prior versions of Internet Explorer do not support full functionality of
WebSphere Commerce tools.

— Attention
The default configuration of Internet Information Services (IIS) installed
by default with Windows 2000 Server Edition and Advanced Server
Edition uses port 80 for HTTP. Running IIS on port 80 will prevent the
WebSphere Commerce server from starting within the WebSphere test
environment. Either uninstall or disable IIS on the WebSphere Commerce
Studio machine or change the HTTP port to a port other than port 80 to
correct this problem.
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Network configuration requirements

In addition to the hardware and software requirements , ensure that the
network configuration of the system meets the following requirements:

* The system must have a resolvable domain name.

The host name combined with the domain name is the fully qualified host
name. For example, if the host name is system1 and the domain is ibm.com®,
the fully qualified host name is system1.ibm.com.

Issuing the following command from a command prompt session should
return the IP address of the system:

nslookup 'fully qualified_host_name'

The desired result is a reply with the correct IP address of the system.

* The IP address on the system must resolve to a host name (including a
domain). To determine if the IP address is mapped to a fully qualified host
name, start a command prompt session and issue the following command:

nslookup 'IP_address'

The desired result is a reply with the correct fully qualified host name of
the system.

* Ensure that the system can be reached from other computers in the network
by pinging the fully-qualified host name of the machine on which you are
installing WebSphere Commerce Studio.

Chapter 3. Before you install WebSphere Commerce Studio 11
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Chapter 4. Quick reference to user IDs and other
information

The WebSphere Commerce Studio installation wizard prompts you for a
number of different user IDs and other information in order to complete the
installation. Before starting your installation of WebSphere Commerce Studio,
fill in the following table so you will have the information handy when you
complete the WebSphere Commerce Studio installation wizard:

User IDs
Review the descriptions in [“User IDs required to complete the]
finstallation wizard” on page 14| then fill in this table:

User ID description User ID Password

Local Windows user 1D

Database administrator ID

WebSphere Commerce Studio
database user ID

BT WebSphere Commerce
Payments database

user ID (required only
when selecting to
create the WebSphere
Commerce Payments
database)

Site Administrator ID

Other information
Review the descriptions in [‘Other information required to complete]
the installation wizard” on page 18| then fill in this table:

Other information Your value

WebSphere Commerce Studio instance
name (optional)

b oracle | Oracle SID

Remote database server host name (remote
database install only)

Remote database server port (remote
database install only)

© Copyright TBM Corp. 1996, 2003 13



Other information Your value

BT Full path of the Oracle

WebSphere Commerce Studio
datafile (optional — a default is
provided)

Full path of the Oracle

WebSphere Commerce Payments
datafile (optional — a default is
provided)

WebSphere Commerce Studio database
name (optional)

Merchant key

WebSphere Commerce Payments instance
password

User IDs required to complete the installation wizard

To complete the installation of WebSphere Commerce Studio, you will need
the following IDs defined:

User ID

Description

Local
Windows
user 1D

To install WebSphere Commerce Studio, the user ID must have
Administrative authority.

If your Windows user ID does not have Administrator authority or is
more than 20 characters in length, or is not defined on the local
machine, you will be notified of the problem and will not be able to
proceed with the installation.
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User ID

Description

Database
administrator
1D

b B2 | This is the Windows user ID for the database

administrator. This ID must be defined on the local
machine. IDs defined on a Windows domain server are
not supported by the WebSphere Commerce Studio
installation program.

This Windows ID can be the same as the user ID used to
install WebSphere Commerce Studio.

Ensure that this Windows user ID has Administrator
authority.

This is the Oracle ID for the database administrator (DBA).
This ID must be defined on the Oracle server machine.

Ensure that this Oracle ID has administrative privileges
(SYSDBA). You may use the Oracle ID SYSTEM.

Note: The Oracle ID SYS cannot be used as the database
administrator ID.

WebSphere
Commerce
Studio
database user
ID

This is the Windows user ID for a database user that
WebSphere Commerce Studio will use to access the
database during development.

If you have created a Windows user ID for the database
user other than the database administrator, you can use
that Windows user ID. Otherwise, use the same Windows
user ID as the database administrator user ID.

Ensure that this Windows user ID has Administrator
authority.

This is the Oracle ID for a database user that WebSphere
Commerce Studio will use to access the database during
development.

Note: The Oracle ID SYS cannot be used as the database
user ID.

This ID is created when the WebSphere Commerce Studio
instance is created as part of the installation process.

Important: The WebSphere Commerce Studio database
user ID must be different from the WebSphere Commerce
Payments database user ID and the database administrator
ID. Failure to have different database user IDs will result
in unexpected behavior.
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User ID Description

WebSphere @7 This ID is not required when using DB2 Universal
Commerce Database as the WebSphere Commerce Payments database.

Payments .
database user b oracle | This is the Oracle ID for a database user that WebSphere

D Commerce Payments will use to access the database
during development.

Note: The Oracle ID SYS cannot be used as the database
user ID.

This ID is created when the WebSphere Commerce
Payments instance is created as part of the installation
process.

Important: The WebSphere Commerce Payments database
user ID must be different from the WebSphere Commerce
Studio database user ID and the database administrator
ID. Failure to have different database user IDs will result
in unexpected behavior.

Site This ID is used to access the WebSphere Commerce tools such as the
Administrator | WebSphere Commerce Accelerator, the WebSphere Commerce

1D Administration Console, and the WebSphere Commerce Organization
Administration Console.

This is not an operating system ID. This ID is created by the
WebSphere Commerce Studio installation wizard.

Site WebSphere Commerce requires that the Site Administrator password
Administrator | adhere to the following rules:

password * Must be at least 8 characters in length.

* Must contain at least one numeric character (0-9)

* Must contain at least one alphabetic character (a-z, A-Z)

» Cannot contain four consecutive occurrences of a character

* The same character cannot appear more than 3 times in the
password.

Notes for DB2 Universal Database users:

1. Windows IDs must be defined on the local machine. IDs defined on a
Windows domain server are not supported by the WebSphere Commerce
Studio installation program.

2. For installing WebSphere Commerce Studio with a local database, all user
IDs can be the same ID on the local machine.

3. The database administrator ID and database user ID must meet DB2
Universal Database user ID requirements outlined in [‘DB2 Universal|
[Database user ID requirements” on page 17
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Notes® for Oracle9i Database users::

1. Windows IDs must be defined on the local machine. IDs defined on a

Windows domain server are not supported by the WebSphere Commerce
Studio installation program.

Oracle IDs must be defined on the Oracle server machine. For installing
WebSphere Commerce Studio with a local database, the Oracle server
machine and WebSphere Commerce Studio machine are the same machine.
For installing WebSphere Commerce Studio with a remote database, the
Oracle server machine and WebSphere Commerce Studio machine are
different machines.

The database administrator ID and database user ID must meet any
requirements for Oracle9i Database user IDs as outlined in the Oracle9i
Database documentation.

Oracle IDs are case-sensitive. Ensure that you have the correct case for the
database administrator ID and the database user ID.

DB2 Universal Database user ID requirements

DB2® requires that the user IDs and passwords for database administrators
and database users adhere to the following rules:

They cannot be more than 20 characters in length.
They can contain only the characters Ato Z,atoz 0to 9, @ # $, and _.
They cannot begin with an underscore (_).

The user ID cannot be any of the following, in upper, lower, or mixed case:
USERS, ADMINS, GUESTS, PUBLIC, LOCAL.

The user ID cannot begin with any of the following in upper, lower, or
mixed case: I1BM, SQL, SYS.

The user ID cannot be the same as any Windows service name.

The user ID must be defined on the local machine, and belong to the Local
Administrator’s group.

The user ID must have the Act as part of the operating system advanced user
right. Restart the computer after having granted this user right.

Refer to your Windows documentation for instructions on setting user
rights.

You can perform the installation without the Act as part of the
operating system advanced user right, however, the DB2 setup
program will be unable to validate the database administrator ID. It
is recommended that any user account used to install DB2 has this
advanced user right.
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Other information required to complete the installation wizard

To complete the installation of WebSphere Commerce Studio, you will need to
know the following additional information:

Studio instance
name (optional —
a default
instance name is
provided)

Information Description
WebSphere The is the name of the WebSphere Commerce Studio instance.
Commerce

The default instance name is Demo_Dev.

Oracle SID

This is the Oracle9i Database System Identifier (SID) for the Oracle
instance containing the WebSphere Commerce Studio database.
The SID was created when you created and configured the
WebSphere Commerce Studio database on Oracle9i Database by
following the instructions in [Chapter 11, “Oracle9i Database|
|settings for WebSphere Commerce Studio,” on page 47

The Oracle SID is case-sensitive. Ensure that you have the correct
case for this information.

This is not required when using DB2 Universal Database as the
WebSphere Commerce Studio database.

Remote database
server host name

This is the TCP/IP host name of the remote database server
machine.

This is required only when installing WebSphere Commerce Studio
with a remote database.

Remote database
server port

This is the port number on which the remote database server
listens for connections from clients.

B The default port is 50000.

The default port is 1521.

This is required only when installing WebSphere Commerce Studio
with a remote database.
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Information

Description

Full path of the
Oracle
WebSphere
Commerce
Studio datafile

This is full path for the datafile (.dbf file) for the WebSphere
Commerce Studio tablespace.

If you are using a remote database, this path must be the actual
path on the remote machine, not a local path using a mapped
drive.

Tablespace and default datafile path information is provided in

“Tablespace and datafile information for WebSphere Commerce|

Studio” on page 48]

Full path of the
Oracle

This is full path for the datafile (.dbf file) for the WebSphere
Commerce Payments tablespace.

WebSphere
Commerce If you are using a remote database, this path must be the actual
Payments path on the remote machine, not a local path using a mapped
datafile drive.
Tablespace and default datafile path information is provided in
“Tablespace and datafile information for WebSphere Commerce]
Studio” on page 48]
WebSphere This is the name of the WebSphere Commerce Studio database.
Commerce

Studio database
name (optional —
a default
database name is
provided)

The default WebSphere Commerce Studio database
name is Demo_Dev.

The default WebSphere Commerce Studio database
name is DemoDev.

Oracle

The database name must match the SID for the
database.

If you have an existing WebSphere Commerce Studio, Version 5.5

database you want to use, record the name of the existing
WebSphere Commerce Studio database.

Databases for WebSphere Commerce Studio, Version 5.4 and lower

must be migrated before they can be used as a WebSphere

Commerce Studio, Version 5.5 database. Migration instructions are

provided in WebSphere Commerce Studio Migration Guide.
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Information

Description

Merchant key

The merchant key is a 16-digit hexadecimal number that meets the
following criteria:

e Must contain at least one numeric character (0-9)

* Must contain at least one alphabetic character (a—f)
Important: Upper-case letters are not valid in the merchant key.

¢ Cannot contain four consecutive occurrences of a character

A hexadecimal number can only contain the following numbers
and letters: 0, 1,2, 3,4,5,6,7,8,9,ab,c,d, e f.

The merchant key is used by the WebSphere Commerce
Configuration Manager as an encryption key. You must enter your
own key in the Merchant key field. Ensure that the key that you
enter will be sufficient to protect your site. After you have created
a store you can only change this key by using the Database
Update Tool. To use this tool, access Configuration Manager,
navigate to the database node for the WebSphere Commerce
instance, right-click on the database node, and select Run
Database Update Tool.

WebSphere
Commerce
Payments
instance
password

This is the password used by WebSphere Commerce Payments to
connect to the WebSphere Commerce Payments database and
decrypt any sensitive data that is stored in the database.

This password will be specified when issuing the IBMPayServer
command when starting WebSphere Commerce Payments. For
more details, refer to [“Starting and stopping WebSphere|
[Commerce Payments” on page 83/

The WebSphere Commerce Payments instance password must
meet the following criteria:

* Must be at least 8 characters in length.

* Must contain at least one numeric character (0-9)

* Must contain at least one alphabetic character (a—z, A-Z)

» Cannot contain four consecutive occurrences of a character

* The same character cannot appear more than 3 times in the
password.
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Part 2. Installing WebSphere Commerce Studio

The chapters in this section describe how to install WebSphere Commerce
Studio.

Review [Chapter 2, “Planning your WebSphere Commerce Studio installation,”]
fon page 7| before installing WebSphere Commerce Studio.

To install WebSphere Commerce Studio, complete the tasks in one of the
following sections:

« [Chapter 5, “Installing WebSphere Commerce Studio with a local database,’]
on page 23|

* [Chapter 6, “Installing WebSphere Commerce Studio with a remote]
database,” on page 25

After completing either of those sections, complete the tasks in[Chapter 7]
“Installing WebSphere Commerce Studio,” on page 27| and [ Applying required|
software updates to WebSphere Studio Application Developer” on page 39|

Note: This part describes how to install WebSphere Commerce Studio using
the CDs provided with the product box. If you copy one or more of the
CDs to a network for the purposes of installing from a network drive,
it is recommended that you do not change the names of the folders,
paths, and directories that are on the CDs. During the installation
process, if you are prompted for a component or CD, you must specify
the location of the component, which is the top level directory on the
CD.

Important information for iSeries developers: Using WebSphere Commerce
Studio with a remote database on iSeries is not supported. To develop for
WebSphere Commerce running on iSeries, use WebSphere Commerce Studio
with a local DB2 database and then use the supplied tools to deploy any
developed code to the iSeries machine.

Information about deploying code to an iSeries machine from a WebSphere
Commerce Studio machine is provided in WebSphere Commerce Programming
Guide and Tutorials.

Important
WebSphere Commerce Studio only supports databases running on
Windows.
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Chapter 5. Installing WebSphere Commerce Studio with a
local database

In this configuration, WebSphere Commerce Studio and the WebSphere
Commerce Studio database are installed on the same machine.

Using DB2 Universal Database as the local WebSphere Commerce Studio

database

If you use DB2 Universal Database as the local WebSphere Commerce Studio
database, no additional steps are required. DB2 Universal Database is installed
and the WebSphere Commerce Studio database is created and configured as
part of the WebSphere Commerce Studio installation.

Using Oracle9i Database as the local WebSphere Commerce Studio database

If you use Oracle9i Database Release 2 as the WebSphere Commerce Studio
database, you must install and configure Oracle9i Database before installing
WebSphere Commerce Studio.

Ensure that you install the following Oracle9i Database Release 2 components
according to the instructions found in the Oracle9i Database documentation:

* Oracle9i Database

* Oracle Net Services

* Oracle Net Protocol Support
* SQL*Plus

* Oracle JDBC/Thin Interfaces
* Oracle JDBC/OCI Interfaces

After installing Oracle9i Database, you must create and configure a
WebSphere Commerce Studio database before installing WebSphere Commerce
Studio. Settings for the database are listed in [Chapter 11, “Oracle9i Database]
lsettings for WebSphere Commerce Studio,” on page 47

The Oracle user IDs will be created and the WebSphere Commerce Studio
database will be populated as part of the WebSphere Commerce Studio
installation.
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The next step

After completing the instructions in this chapter, proceed with your
installation of WebSphere Commerce Studio by following the instructions in
[Chapter 7, “Installing WebSphere Commerce Studio,” on page 27
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Chapter 6. Installing WebSphere Commerce Studio with a
remote database

In this configuration, WebSphere Commerce Studio and the WebSphere
Commerce Studio database are installed on different Windows machines.
Databases on operating systems other than Windows are not supported by
WebSphere Commerce Studio.

Using DB2 Universal Database as the remote WebSphere Commerce Studio
database
If you use DB2 Universal Database as the remote WebSphere Commerce
Studio database, you must install DB2 Universal Database on a Windows
system before installing WebSphere Commerce Studio. To install DB2

Universal Database as the WebSphere Commerce Studio database, do the
following:

1. Install DB2 Universal Database on the remote machine.

2. On the remote DB2 Universal Database server machine, check that an
entry similar to the following exists in the services file:

db2c_DB2 50000/tcp #connection port

The services file can be found in the following directory:
C:\winnt\system32\drivers\etc

After completing these steps, continue with the instructions in
[“Installing WebSphere Commerce Studio,” on page 27] The WebSphere
Commerce Studio database is created and configured as part of the
WebSphere Commerce Studio installation. You can also choose to use an
existing WebSphere Commerce Studio, Version 5.5 database during the
installation.

Using Oracle9i Database as the remote WebSphere Commerce Studio database

If you use Oracle9i Database Release 2 as the WebSphere Commerce Studio
database, you must install Oracle9i Database on a remote Windows system
before installing WebSphere Commerce Studio. To install Oracle9i Database as
the WebSphere Commerce Studio database, do the following:

1. Install the following Oracle9i Database components on the Oracle9i
Database server machine according to the instructions found in the
Oracle9i Database documentation:

¢ Oracle9i Database
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Oracle Net Services
Oracle JDBC/Thin Interfaces
Oracle JDBC/OCI Interfaces

2. Install the following Oracle9i Database components on the WebSphere
Commerce Studio (Oracle9i Database client) machine according to the
instructions found in the Oracle9i Database documentation:

Oracle9i Enterprise Client
SQL*Plus

Oracle JDBC/Thin Interfaces
Oracle JDBC/OCI Interfaces
Oracle Network Utilities
Oracle Database Utilities

3. Ensure that the Oracle client and server are configured to communicate
correctly according to instructions found in the Oracle9i Database
documentation.

After installing the Oracle9i Database server and client, you must create and

configure a WebSphere Commerce Studio database before installing
WebSphere Commerce Studio. Settings for the database are listed in

Chapter 11, “Oracle9i Database settings for WebSphere Commerce Studio,” on|

page 47]For instructions on creating and configuring an Oracle database, refer

to the Oracle9i Database documentation.

The WebSphere Commerce Studio installation wizard does the following
when you select Create WebSphere Commerce Studio database in the
wizard:

* creates the Oracle user IDs for WebSphere Commerce Studio and
WebSphere Commerce Payments

* creates the tablespaces for WebSphere Commerce Studio and WebSphere
Commerce Payments

* populates the WebSphere Commerce Studio and WebSphere Commerce
Payments databases.

The next step

After completing the instructions in this chapter, proceed with your

installation of WebSphere Commerce Studio by following the instructions in

[Chapter 7, “Installing WebSphere Commerce Studio,” on page 27.|
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Chapter 7. Installing WebSphere Commerce Studio

To install WebSphere Commerce Studio, you must be logged in as a user with
Administrator authority.

Note: If you have either an HTTP Server or WebSphere Application Server
installed on the machine on which you want to install WebSphere
Commerce Studio, ensure that the HTTP server and WebSphere
Application Server are not running before installing WebSphere
Commerce Studio.

The machine on which you are installing WebSphere Commerce
Studio requires 1.25 GB of temporary hard drive space on the C:
drive during the installation.

If 1.25 GB of temporary hard drive space is not available, you can
reduce the free space requirements by following the instructions in
Chapter 12, “Installing WebSphere Commerce Studio on systems|
with less than 1 GB of temporary hard drive space,” on page 49.|
After completing these instructions, the temporary hard drive space
requirements are reduced to 300 MB.

To install WebSphere Commerce Studio, do the following:

1. Review the information in [Chapter 2, “Planning your WebSphere|
[Commerce Studio installation,” on page 7[to ensure that you have
selected the correct configuration to install.

2. Complete the tasks in[Chapter 3, “Before you install WebSphere|
[Commerce Studio,” on page 9

3. Do one of the following, depending on the type of database program you
are using for the WebSphere Commerce Studio database:

« BT Complete the steps in [“Using DB2 Universal Database as thel
[local WebSphere Commerce Studio database” on page 23]

« B Complete the steps in [“Using DB2 Universal Database as the]
[remote WebSphere Commerce Studio database” on page 25/

o BETM Complete the steps in[“Using Oracle9i Database as the locall
|WebSphere Commerce Studio database” on page 23/

« BT Complete the steps in [“Using Oracle9i Database as the remote]
[WebSphere Commerce Studio database” on page 25]

4. Insert WebSphere Commerce Studio CD 1 into the CD-ROM drive.
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If the installation program does not automatically start, launch the
setup.exe program located at the root of the CD.

5. Select the language you want to use during the install and click OK.
A check is performed to ensure that the system meets the pre-installation
requirements.
If your system meets the pre-installation requirements the Welcome page
displays.
If your system does not meet the pre-installation requirements, a dialog
box will open detailing the requirements which have not been met. Click
Cancel and then Exit Setup to exit the installation program. Take the

appropriate steps to meet the pre-installation requirements which were
listed and begin the installation again.

6. If your system meets the pre-installation requirements, the Welcome page
displays. Click Next to continue.

7. The Software License Agreement page displays. Review the terms of the
license agreement in the Software License Agreement page.

If you accept the terms of the license agreement, click Accept to accept
the terms of the license agreement and continue installing WebSphere
Commerce Studio.

If you decline the terms of the license agreement, click Decline. Declining
the terms of the license agreement exits the WebSphere Commerce Studio
install program.

8. If you have accepted the terms of the license agreement, the WebSphere
Commerce Studio Instance Information page displays. Enter the
following information:

* WebSphere Commerce Studio instance name

* Merchant key

* WebSphere Commerce Payments instance password
* Site Administrator ID

* Site Administrator password

Descriptions of these items can be found in [Chapter 4, “Quick reference]
[to user IDs and other information,” on page 13.| Ensure that the merchant
key and WebSphere Commerce Payments instance password meet all the
requirements listed in that section.

Click Next to continue.

9. The WebSphere Commerce Studio Database Information page displays.
Complete the fields on this page as follows:

WebSphere Commerce Studio database name
Enter the name of the WebSphere Commerce Studio database. A
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description of this item can be found in [Chapter 4, “Quick|
[reference to user IDs and other information,” on page 13/

B The database name must match the SID for the
database.

Database Type
Select the database management system you want to use for the
WebSphere Commerce Studio database. WebSphere Commerce
Studio supports DB2 Universal Database and Oracle9i Database.

S 1f you select DB2 Universal Database as the database
and an earlier version is detected, you will receive an error
message. Exit the installation wizard and upgrade the version of
DB2 to Version 8.1.1 (Version 8.1 with FixPak 1) before restarting
the installation wizard.

Create WebSphere Commerce Studio database
Clear or select this check box as follows:

* If you want to create a new WebSphere Commerce Studio
database, ensure this check box is selected.

During the install, one of the following occurs:

— BIZ The WebSphere Commerce Studio and WebSphere
Commerce Payments databases are created and populated.

~ BT The WebSphere Commerce Studio and WebSphere
Commerce Payments tablespaces are created and populated.
Also, the Oracle user IDs required for WebSphere Commerce
Studio and WebSphere Commerce Payments are created.

The database used by WebSphere Commerce Studio and
WebSphere Commerce Payments must be created before
installing WebSphere Commerce Studio.

If a database called Demo_Dev or wpm already exists, ensure that
you do not use the database user ID for the existing database
as the database user ID entered into the installation wizard
later on.

* If you want to use an existing WebSphere Commerce Studio
database, ensure this check box is cleared.

The existing WebSphere Commerce Studio database must be a
database for WebSphere Commerce Studio, Version 5.5.
Databases for WebSphere Commerce Studio, Version 5.4 and
lower must be migrated before they can be used as a
WebSphere Commerce Studio, Version 5.5 database. Migration
instructions are provided in WebSphere Commerce Studio
Migration Guide.
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When using an existing WebSphere Commerce Studio
database, ensure that the database name in the WebSphere
Commerce Studio database name field matches the name of
the existing WebSphere Commerce Studio database.

— Attention
If you choose to use an existing WebSphere Commerce
Studio database, the WebSphere Commerce Payments
instance will not be created by the installation wizard.

WebSphere Commerce Payments does not support using an
existing WebSphere Commerce Payments database.

The WebSphere Commerce Payments instance must be
created manually if you choose to use an existing database.
Instructions for creating a WebSphere Commerce Payments
instance manually are provided in [‘Creating a WebSphere]
[Commerce Payments instance” on page 72

Use remote WebSphere Commerce Studio database
Clear or select this check box as follows:

* To use WebSphere Commerce Studio with a local database,
ensure this check box is cleared.

* To use WebSphere Commerce Studio with a remote database,
ensure this check box is selected.

When you have completed all the fields, click Next to continue.

10. The next WebSphere Commerce Studio Database Information page
displays. Enter the following information:

¢ Database administrator ID
e Database administrator password
e Database user ID

* Database user password

« BCZTM Oracle SID
« BETM Payments database user ID
« BZTM Payments database user password

Descriptions of these items can be found in [Chapter 4, “Quick reference]
[to user IDs and other information,” on page 13|
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11.

12.

13.

14.

Important:

a. The Payments user ID and password fields are only displayed if you
selected the Create WebSphere Commerce Studio database check
box.

b. IDs, passwords, and the Oracle SID are case-sensitive. Ensure that you
have the correct case for this information.

c. The Database user ID and Payments database user ID must be
different from the database administrator ID. Using the same ID for
both the database user, the Payments database user, and the database
administrator ID will result in unexpected behavior.

Click Next to continue.

S 1f you chose to use Oracle with WebSphere Commerce Studio
and selected Create WebSphere Commerce Studio database, another
WebSphere Commerce Studio Database Information page displays. Enter
the following information:

* Full path of WebSphere Commerce Studio datafile

* Full path of WebSphere Commerce Payments datafile

Descriptions of these items can be found in[Chapter 4, “Quick reference|
[to user IDs and other information,” on page 13/

Click Next to continue.

If you selected the Use remote WebSphere Commerce Studio database
check box, the Remote Database Information page displays. Enter the
following information:

* Database server host name

* Database server port

Descriptions of these items can be found in [Chapter 4, “Quick reference]
[to user IDs and other information,” on page 13

Click Next to continue.

The Target Database Information page displays. Select the target database
type and click Next.

Note: If you selected Oracle9i Database as the development database,
you must select Oracle9i Database as the deployment database.
Developing on Oracle9i Database for deployment to DB2 Universal
Database is not supported.

The Choose Destination page displays. You can accept the default
destination paths or change them. Click Next to continue installing
WebSphere Commerce Studio.
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Note: Due to limitations on the length of environment variables, the
destination paths must be no more than two directories deep. For
example: C:\WebSphere\CommerceStudio55. If the destination
paths are too deep, the CLASSPATH environment variable will
exceed the 256 character limit for Windows environment variables.
An incorrect CLASSPATH environment variable will adversely
affect the function of WebSphere Commerce Studio.

15. The Documentation Language Selection page displays. Select the
languages in which you want the WebSphere Commerce Studio online
documentation available. Click Next to continue installing WebSphere
Commerce Studio.

16. The Summary page displays. Review the installation options to ensure
they are correct, then click Next.

17. The installation wizard continues by installing and configuring the
WebSphere Commerce Studio components.

Follow the prompts and replace the CD in the CD-ROM drive with the
CD the prompt requests. The number of times you will need to change
CDs depends on the number of components that must be installed.

The installation wizard does the following:

Installing WebSphere Studio Application Developer, if required.
If WebSphere Studio Application Developer, Version 5.0 is already
installed on the machine, this step is skipped.

Installing DB2 Universal Database, if required.
This step is skipped if any of the following are true:

* IBM DB2 Universal Database Enterprise Server Edition Version
8.1.1 is already installed on the machine.

* You chose to use Oracle9i Database as the WebSphere
Commerce Studio database.

* You chose to use an existing WebSphere Commerce Studio,
Version 5.5 database.

Installing the DB2 Universal Database Administration Client, if required
This step only occurs if you are using DB2 Universal Database as
the WebSphere Commerce Studio database and you selected Use
remote WebSphere Commerce Studio database in the
installation wizard.

This step is skipped if the DB2 Universal Database
Administration Client is detected on the machine.

Installing WebSphere Commerce Studio
The installation wizard installs any remaining WebSphere
Commerce Studio components and WebSphere Commerce
Payments.
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18.

Creating the WebSphere Commerce Studio instance.
After successful creation of the WebSphere Commerce Studio
instance, a dialog displays.

If the instance creation fails you can manually create a
WebSphere Commerce Studio instance by following the
instructions in|“Creating a WebSphere Commerce Studio|
[instance” on page 71/

Click OK to dismiss the dialog and continue the installation.

Creating the WebSphere Commerce Payments instance.
This step is skipped if you cleared the Create WebSphere
Commerce Studio database check box. In this case, you must
create the WebSphere Commerce Payments instance manually.

After successful creation of the WebSphere Commerce Payments
instance, a dialog displays.

If the instance creation fails you can create a WebSphere
Commerce Payments instance manually by following the
instructions in [“Creating a WebSphere Commerce Payments|
[instance” on page 72]

Click OK to dismiss the dialog and continue the installation.

Importing the WebSphere Commerce workspace into WebSphere Studio
Application Developer
After the WebSphere Commerce workspace imports successfully,
a dialog displays indicating the location of the workspace import
log. Click OK to dismiss the dialog and continue the installation.

Installing the WebSphere Application Server fixes required by the WebSphere
test environment
These fixes allow you to successfully run WebSphere Commerce
in the WebSphere test environment.

The installation of WebSphere Commerce Studio is complete when the
Reboot Computer dialog displays. Remove the CD from the CD-ROM
drive and select whether you will reboot the WebSphere Commerce
Studio machine now or later.

Click Finish to exit the installation wizard.

You must reboot the WebSphere Commerce Studio machine before verifying
that the installation of WebSphere Commerce Studio was successful. To verify
that the installation of WebSphere Commerce Studio was successful, follow
the instructions in |Chapter 8, “Verifying your installation,” on page 35.|

During the installation, the WebSphere Commerce Studio creates and
populates the following directory:
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C:\WCTemp

You may delete this directory after completing the installation.

The next step

After completing the instructions in this chapter, do the following:

1. Verify the installation of WebSphere Commerce Studio by following the
instructions in [Chapter 8, “Verifying your installation,” on page 35]

2. Complete the mandatory post-installation tasks outlined in
[‘Mandatory post-installation tasks,” on page 39
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Chapter 8. Verifying your installation

As the WebSphere Commerce Studio installation progresses, log files are
generated. These log files contain messages indicating a successful installation
or where errors occurred during a failed installation.

Verify your installation of WebSphere Commerce Studio by examining the
following log files:

. ['DB2 Universal Database installation log.”|
[“WebSphere Studio Application Developer installation log” on page 36|

["'WebSphere Commerce Studio workspace import log” on page 36.|

[“WebSphere Commerce Studio instance creation logs” on page 37|

["WebSphere Commerce Studio fix installation log” on page 38

* ["WebSphere Commerce Studio installation log” on page 38|

If all of these logs indicate success, your installation of WebSphere Commerce
Studio was successful.

DB2 Universal Database installation log

Examine the DB2 Universal Database install log if you chose to install
WebSphere Commerce Studio with a local DB2 Universal Database.
Otherwise, verify your WebSphere Commerce Studio installation by
examining the other log files discussed in this section.

This log contains messages generated during the installation of DB2 Universal
Database. The default location for this log file is:

C:\Documents and Settings\user_id\Local Settings\Temp\db2wi.log

where user_id is the local Windows user ID you were logged in as when
installing WebSphere Commerce Studio.

DB2 Universal Database installed successfully if the last line in the log file
contains the following text:

Product: DB2 Enterprise Server Edition --
Installation operation completed successfully.

This message has been formatted for this book. In the log file, the message
appears as a single line.
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WebSphere Studio Application Developer installation log

This log contains messages generated during the installation of WebSphere
Studio Application Developer. The default location for this log file is
C:\WINNT\wsad50.1og.

WebSphere Studio Application Developer installed successfully if the last line
of the log file is the following:

MST (c) (A4:54): Product: IBM WebSphere Studio Application Developer 5 --
Installation operation completed successfully.

The formatting of the message here is for display purposes only. In the log
file, this message appears on a single line.

If your WebSphere Studio Application Developer installation log does not
contain this line, examine the log carefully to find any errors that occurred
during the installation.

WebSphere Commerce Studio workspace import log

After creating a WebSphere Commerce Studio instance, the installation
imports the WebSphere Commerce Studio workspace into WebSphere Studio
Application Developer.

The workspace import log file is located in the following path:
WCStudio_installdir\logs\import_workspace.log

The default value for WCStudio_installdir is listed in |[“Path variables” on page]

The WebSphere Commerce Studio workspace was imported into WebSphere
Studio Application Developer successfully if there are no exceptions listed in
the file for each project that was imported and the following message appears
near the end of the file:

BUILD SUCCESSFUL

The workspace import log file has one line for each project imported in the
section starting with importProjects:. The line for each project begins with
[importProject]. A project is imported successfully if no exceptions appear in
the log file after the [importProject] line for the project. If any exceptions
occurred while a project was being imported, the project must be imported
manually. Refer to [“Importing a project manually” on page 90| for instructions.

36  WebSphere Commerce Studio Installation Guide



WebSphere Commerce Studio instance creation logs

Instance creation during the WebSphere Commerce Studio installation creates
the following log files:

* auction.log
* createdb.log
¢ createdb.production.log

« B createdb_db2.log
* createsp.log

* createsp.errlog

* populatedb.err.log
* populatedbx.err.log
* populatedb.log

* populatedbx.log

* populatedbnl.log

* populatedbnl.err.log
* reorgdb2.log

* reorgdb2.err.log

* trace.txt

where x is a number.

The files are located in the following directory:
WCStudio_installdir\Commerce\instances\instance_name\10gs

where instance_name is the name of WebSphere Commerce Studio instance.

Instance creation is successful if the following logs are empty:
* createsp.errlog

* populatedb.err.log

* populatedbx.errlog

* populatedbnl.err.log

* reorgdb2.err.log

Also, review the contents of the following logs to confirm they do not contain
any errors:

* createdb.log
« B createdb_db2.log
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If instance creation failed, the WebSphere Commerce Studio instance can be
created manually by following the instructions in [“Creating a WebSphere]
[Commerce Studio instance” on page 71/

WebSphere Commerce Studio fix installation log

The WebSphere Commerce Studio fix installation log contains a summary of
the fix installation process and is located in the following path:

WCStudio_installdir\logs\wcWASefixer.log

The default value for WCStudio_installdir is listed in|“Path variables” on page|

The WebSphere Commerce Studio fixes installed successfully if the following
message appears at the end of the file:

Fix installation completed successfully.

WebSphere Commerce Studio installation log

The WebSphere Commerce Studio installation log contains a summary of the
overall installation process and is located in the following path:

WCStudio_installdir\l1ogs\WCStudioInstall.log

The default value for WCStudio_installdir is listed in |”Path variables” on page|

The WebSphere Commerce Studio installation is complete if the following
message appears at the end of the file:

WebSphere Commerce Studio Setup Complete

The next step

After completing the instructions in this chapter, complete the mandatory
post-installation tasks outlined in [Chapter 9, “Mandatory post-installation|
[tasks,” on page 39] These steps include:

* Applying any available updates to WebSphere Studio Application
Developer by following the instructions in [“Applying required software]
[updates to WebSphere Studio Application Developer” on page 39

* Updating the data source information for the WebSphere Commerce server
in WebSphere Studio Application Developer by following the instructions in
[“Updating the WebSphere Commerce server data source” on page 39.|
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Chapter 9. Mandatory post-installation tasks

After installing WebSphere Commerce Studio and verifying that the
installation was successful, you must complete the following tasks before
using WebSphere Commerce Studio:

1. ["Applying required software updates to WebSphere Studio Application|
Develoger.”|

2. [“Updating the WebSphere Commerce server data source.”|

Failure to complete these tasks will result in an inability to run WebSphere
Commerce and WebSphere Commerce Payments in the WebSphere test
environment.

Applying required software updates to WebSphere Studio Application Developer

After you have successfully installed WebSphere Commerce Studio, you must
apply software updates to WebSphere Studio Application Developer. Failure
to install these updates will cause the customizations made to WebSphere
Studio Application Developer by WebSphere Commerce Studio to function
incorrectly.

To obtain the updates and instructions for installing the updates, refer to the
following URL:

[http://www3.software.ibm.com/ibmd1/pub/software/websphere/|
[studiotools/html/ptf001/wsad50/install.html]

The formatting of the URL here is for display purposes only. Enter the URL as
a single line.

Updating the

WebSphere Commerce server data source

Before you can start the WebSphere Commerce server in the WebSphere test
environment, you must update the WebSphere Commerce server data source
with the correct database user password.

To update the WebSphere Commerce server data source, do the following;:

1. Start WebSphere Commerce Studio by selecting Start » Programs » IBM
WebSphere Commerce Studio * WebSphere Commerce development
environment.

2. In the J2EE Hierarchy view of the J2EE Perspective, expand Servers and
double-click WebSphereCommerceServer. The
WebSphereCommerceServer view displays.
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In the WebSphereCommerceServer view, select the Data source page.

On the Data sources page, expand Server Settings.

In the JDBC provider list table, select one of the following, depending on

the database you are using as the WebSphere Commerce Studio database:
SMLEZN DB2 JDBC Provider

ST Oracle JDBC Thin Driver

After selecting a JDBC provider, the tables below the JDBC provider list
table update.

In the Data source defined in the JDBC provider selected above table,
select one of the following, depending on the database you are using as
the WebSphere Commerce Studio database:

S jdbc/WebSphere Commerce DB2 DataSource instance_name
S jdbc/WebSphere Commerce Oracle DataSource instance_name

where instance_name is the name of the WebSphere Commerce Studio
instance. The default instance name is Demo_Dev.

Click Edit. The Modify Data Source wizard starts.

In the Modify Data Source wizard, replace any value in the Default user
password field with the password for the ID shown in the Default user
ID field. The user ID and password should be the database user ID and
password described in |Chapter 4, “Quick reference to user IDs and otheli
finformation,” on page 13

Click Finish to update the information and close the Modify Data Source
wizard.

Save the updates to the configuration by selecting File » Save
WebSphereCommerceServer.

Note: Updating the WebSphere Commerce Payments server data source is not

required.

The next step

After completing the instructions in this chapter, complete any of the optional
configuration tasks, including:

* (Chapter 10, “Optional post-installation tasks,” on page 43|

Chapter 13, “Configuring payment processing in WebSphere Commerce|

Studio,” on page 53]

Chapter 14, “Configuring WebSphere Studio Application Developer logging]|

tools,” on page 61
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Chapter 15, “Publishing a sample store in WebSphere Commerce Studio,”]

on page 63|

Chapter 16, “Configuring additional WebSphere Commerce software for
WebSphere Commerce Studio,” on page 65|
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Chapter 10. Optional post-installation tasks

After completing the mandatory post-installation tasks, you can complete any
of the optional post-installation tasks including the following:

* [‘Reducing memory requirements for DB2 Universal Database’]

* ['Repackaging WebSphere Commerce adapter JAR files” on page 44|

Reducing memory requirements for DB2 Universal Database

WebSphere Commerce Studio installs DB2 Universal Database with default
buffer pool values. These values may be higher than those required by your
development environment.

To reduce the memory requirements for DB2 Universal Database, do the
following:
1. Ensure that you are logged in as the DB2 database administrator.

2. Start the DB2 Command Line Processor by selecting Start + Programs »
IBM DB2 » Command Line Tools ®* Command Line Processor.
3. Enter the following commands:

connect to WCStudio_database_name user DB2 admin_ID using DBZ_admin_pwd
alter bufferpool IBMDEFAULTBP size 1000

alter bufferpool BUFF8K size 50

alter bufferpool BUFF16K size 50

alter bufferpool BUFF32K size 50

where the variables are defined as follows:

WCStudio_database_name
The name of the WebSphere Commerce Studio database.

The default name of the database created by the WebSphere
Commerce Studio installation wizard is Demo_Dev.

DB2_admin_ID
The ID for the DB2 Universal Database administrator.

DB2_admin_pwd
The password associated with the DB2 Universal Database
administrator.

4. Close the DB2 Command Line Processor.
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Repackaging WebSphere Commerce adapter JAR files

The instructions in the following section do not apply if you are using
WebSphere Studio Application Developer, Version 5.0.1 or higher.

Repackaging the WebSphere Commerce adapter JAR files is required only if
you plan to use any of the following adapters in WebSphere Commerce
Studio:

* Adapter for WebSphere MQ
* E-mail adapter

* File adapter

* Sample adapter

You can repackage the adapter JAR files at any point before using the
adapters.

To repackage the adapter JAR files, do the following:
1. Create a temporary directory.

2. Extract the following .class files to the temporary directory from
WCStudio_workspacedir/Enablement-
IntegrationLogic/.imported classes.jar:

com. ibm.commerce.messaging.adapters.jca.exception.WcExceptionUtil.class

com. ibm.commerce.messaging.adapters.jca.
exception.WCITlegalArgumentException.class

com. ibm.commerce.messaging.adapters.jca.exception.WcResourceException.class

com.ibm.commerce.messaging.adapters.jcautil.JCATraceHelper.class

com.ibm.commerce.messaging.adapters.jcautil.JCATracing.class

com. ibm.commerce.messaging.adapters.jcautil.Util.class

Default values for WCStudio_workspacedir are listed in [“Path variables” on]
3. Extract the following .class files to the temporary directory from

WCStudio workspacedir/Enablement-

BaseComponentsLogic/.imported classes.jar:

com.ibm.commerce.ras.ECMessageKey.class
com.ibm.commerce.ras.WASLog.class
com. ibm.commerce.ras.WASTrace.class

4. Add the extracted .class files to the following JAR files:

* WCStudio_workspacedir/Enablement-
JCAAEMailConnector/.imported classes.jar

* WCStudio_workspacedir/Enablement-
JCAJMSConnector/.imported classes.jar

* WCStudio_workspacedir/Enablement-
JCAFileConnector/.imported classes.jar
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* WCStudio workspacedir/Enablement-
JCASampleConnector/.imported classes.jar

Important
Ensure that you maintain all path information except for the path to
the temporary directory. All paths in the JAR files should start with
com.

The next step

After completing the instructions in this chapter, complete any of the optional
configuration tasks, including:

* [Chapter 13, “Configuring payment processing in WebSphere Commerce|
Studio,” on page 53

* [Chapter 14, “Configuring WebSphere Studio Application Developer logging]
tools,” on page 61|

* [Chapter 15, “Publishing a sample store in WebSphere Commerce Studio,”]
on page 63|

* [Chapter 16, “Configuring additional WebSphere Commerce software for|
WebSphere Commerce Studio,” on page 65|
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Chapter 11. Oracle9i Database settings for WebSphere
Commerce Studio

This section provides information about recommended settings for Oracle9i
Databases used with WebSphere Commerce Studio.
Notes:

1. WebSphere Commerce Studio only supports Oracle9i Database Release 2,
Enterprise Edition or Standard Edition.

2. You should have advanced knowledge of Oracle (at the DBA level) before
changing the database settings as recommended in this sections

3. For more information about Oracle, go to|http://www.oracle.com You can

obtain copies of the Oracle documentation from
http://otn.oracle.com/documentationl To obtain Oracle software, refer to
http://technet.oracle.comn The Oracle information in this chapter is
provided only as a guideline.

4. For additional information on Oracle terminology and concepts, refer to
the Oracle 9i Concepts document provided with your purchase of Oracle.

— Important
This chapter assumes you have installed the correct Oracle9i Database
components for the WebSphere Commerce Studio configuration you are
installing. If you have not yet installed Oracle9i Database, refer to the
section appropriate for WebSphere Commerce Studio configuration :

* ['Using Oracle9i Database as the local WebSphere Commerce Studio]
database” on page 23|

* ["Using Oracle9i Database as the remote WebSphere Commerce Studio|
database” on page 25|

If you are using a DB2 Universal Database database as the database
for WebSphere Commerce Studio, you do not need to complete the
steps in this chapter.
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Required Oracle9i Database settings for WebSphere Commerce Studio

The following table lists required and strongly recommended database
parameter settings to use when using Oracle9i Database with WebSphere
Commerce Studio:

Table 1. Required database parameter settings for Oracle9i Database

Parameter Value
block size 4KB (strongly recommended)
character set UTF-8

Refer to the Oracle9i Database documentation for instructions on setting or
changing database parameters.

Recommended Oracle9i Database settings for WebSphere Commerce Studio

The following table lists recommended database parameter settings to use
when using Oracle9i Database with WebSphere Commerce Studio:

Table 2. Recommended database parameter settings for Oracle9i Database

Parameter Value
db_cache_size 32MB
open_cursors 1000
pga_aggregate_target 50MB
shared_pool_size 32MB
sort_area_size 655350

Refer to the Oracle9i Database documentation for instructions on setting or
changing database parameters.

Tablespace and datafile information for WebSphere Commerce Studio

As part of the installation process, WebSphere Commerce Studio creates the
tablespaces for WebSphere Commerce Studio and WebSphere Commerce
Payments. The following table summarizes the tablespaces and datafiles
created as part of the installation process:

Database Tablespace name |Default full path to datafile
WebSphere WCTBLSPC drive:\oracle\ora92\database\wcs.dbf
Commerce

WebSphere WPMTBLSPC drive:\oracle\ora92\database\wpm.dbf
Commerce

Payments
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Chapter 12. Installing WebSphere Commerce Studio on
systems with less than 1 GB of temporary hard drive
space

If the machine on which you are installing WebSphere Commerce Studio has
less than 1 GB of temporary space available on the C: drive, do the following;:

1. Install WebSphere Studio Application Developer on the WebSphere
Commerce Studio machine by following the instructions in the IBM
WebSphere Studio Application Developer, Version 5.0 Installation Guide
(install.pdf) in the root of WebSphere Studio Application Developer CD
1.

2. Install WebSphere Commerce Studio by following the instructions in
[Chapter 7, “Installing WebSphere Commerce Studio,” on page 27

When WebSphere Studio Application Developer is installed before WebSphere
Commerce Studio, the requirement for 1 GB of available temporary space on
the C: drive no longer applies.
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Part 3. Configuring WebSphere Commerce Studio

The chapters in this section describe how to perform any of the optional
configurations for WebSphere Commerce Studio beyond the initial
configuration when you install WebSphere Commerce Studio. Topics covered
in this section include:

+ [Chapter 13, “Configuring payment processing in WebSphere Commerce]
Studio,” on page 53

+ [Chapter 14, “Configuring WebSphere Studio Application Developer logging]
tools,” on page 61|

* [Chapter 15, “Publishing a sample store in WebSphere Commerce Studio,”|
on page 63|

* [Chapter 16, “Configuring additional WebSphere Commerce software for|
WebSphere Commerce Studio,” on page 65|
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Chapter 13. Configuring payment processing in
WebSphere Commerce Studio

To test a store based on a WebSphere Commerce sample store, you should be
able to complete an entire shopping flow, including completing a purchase.

For more information on the Express Store, refer to WebSphere Commerce -
Express Easy Start Guide.

To complete a purchase in a sample store, the development environment must
be configured to use one of the following payment processing methods:

¢ WebSphere Commerce Payments on the development machine.
¢ WebSphere Commerce Payments on a remote machine

For more information on the FashionFlow sample stores, refer to WebSphere
Commerce Sample Store Guide.

Installing WebSphere Commerce Studio creates a WebSphere Commerce
Payments instance on the development machine. The development
environment is initially configured to use this local WebSphere Commerce
Payments instance. Depending on your development requirements you may
want to change the development environment configuration to use WebSphere
Commerce Payments on a remote machine.

Configuring the development environment to use WebSphere Commerce
Payments on the development machine

WebSphere Commerce Payments is configured on the development machine
when WebSphere Commerce Studio is installed. After installing WebSphere
Commerce Studio, you must configure payment methods in WebSphere
Commerce Payments. For more details, refer to|“Configuring accepted|
fpayment methods in WebSphere Commerce Payments” on page 58.|

To use WebSphere Commerce Payments in the WebSphere test environment,
start WebSphere Commerce Payments according to the instructions in
[“Starting and stopping WebSphere Commerce Payments” on page 83)

If you want to configure the development environment to use WebSphere
Commerce Payments on a remote machine, follow the instructions in
“Configuring the development environment to use WebSphere Commerce|
Payments on a remote machine” on page 55
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If you have configured the development environment to use WebSphere
Commerce Payments on a remote machine and you want to return to using
WebSphere Commerce Payments on the development machine, follow the
instructions in [“Switching from remote WebSphere Commerce Payments tol
[local WebSphere Commerce Payments.”|

Switching from remote WebSphere Commerce Payments to local
WebSphere Commerce Payments
If you have configured the development environment to use WebSphere
Commerce Payments on a remote machine and you want to return to using
WebSphere Commerce Payments on the development machine, do the
following:

1. If you are running WebSphere Commerce in the WebSphere test
environment, stop WebSphere Commerce. For detailed instructions, refer
to [“Stopping WebSphere Commerce” on page 83

2. Start Configuration Manager. For detailed instructions, refer to ["Starting]
[WebSphere Commerce Configuration Manager” on page 81

3. In the navigation area, expand WebSphere Commerce + host_name
Commerce » InstanceList » instance_name » InstanceProperties, then select
Payments.
where host_name is the TCP/IP host name of the machine running
WebSphere Commerce Studio and instance_name is the name of WebSphere
Commerce Studio instance. The default WebSphere Commerce Studio
instance is Demo_Dev.

4. Fill in the fields on the Payments page as follows:
Hostname

Enter the fully qualified host name of the WebSphere Commerce
Studio machine. Do not use localhost in this field.

Profile Path
Ensure the path is the following:

WCStudio_installdir/Commerce/instances/instance_name/xm1/payment
where instance_name is the name of WebSphere Commerce Studio
instance.

Use non-SSL Payments Client
Ensure this box is not selected.

Webserver Port
Enter 5433.

Use Socks Server
Ensure this check box is not selected.
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Socks Hostname
This field should be disabled because the Use Socks Server check
box is not selected.

Socks Port Number
This field should be disabled because the Use Socks Server check
box is not selected.
5. Click Apply. If the changes are applied successfully, a message displays.
Click OK to dismiss the message.

6. Stop Configuration Manager. For detailed instructions, refer tol“Stoppingl
[WebSphere Commerce Configuration Manager” on page 82

Configuring the development environment to use WebSphere Commerce
Payments on a remote machine

Before you can configure your development environment to use a remote
WebSphere Commerce Payments, you must install and configure WebSphere
Commerce Payments on a machine separate from your development machine.

To configure the development environment to use WebSphere Commerce

Payments on a remote machine, do the following;:

1. Install and configure WebSphere Commerce Payments on the remote
machine. For more instructions, refer to|“Installing and configuring|
[WebSphere Commerce Payments.”|

2. Configure the WebSphere Commerce Studio instance to use a remote

WebSphere Commerce Payments. For more details, refer to |”Configuring a|
WebSphere Commerce Studio instance to use a remote WebSphere|
Commerce Payments” on page 56/

3. Configure payment methods in WebSphere Commerce Payments. For more
details, refer to|“Configuring accepted payment methods in WebSphere|
[Commerce Payments” on page 58]

If you have configured the development environment to use WebSphere
Commerce Payments on a remote machine and you want to return to using
WebSphere Commerce Payments on the development machine, follow the
instructions in [“Switching from remote WebSphere Commerce Payments to|
local WebSphere Commerce Payments” on page 54)

Installing and configuring WebSphere Commerce Payments
To install and configure WebSphere Commerce Payments on a machine
separate from your development machine, do the following:
1. Complete a custom installation of WebSphere Commerce on the remote
machine. During the installation, select the following components when
completing the custom installation:
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* WebSphere Commerce Payments, including WebSphere Application
Server base product

* IBM HTTP Server, including WebSphere Application Server plug-in

Instructions for completing a custom installation are provided in WebSphere
Commerce Installation Guide.

2. Create a WebSphere Commerce Payments instance by following the
instructions in WebSphere Commerce Installation Guide.

Ensure that you enter the fully qualified host name of the WebSphere
Commerce Studio machine in the WC Hostname field of the WCSRealm
panel of the Payments Instance Creation wizard.

Also, ensure that you use specify a unique database name — if the
database name already exists, instance creation will fail. The default name
for the WebSphere Commerce Payments database is WPM.

3. Start IBM HTTP Server according to the IBM HTTP Server documentation.

4. Start WebSphere Commerce Payments by following the instructions in
WebSphere Commerce Installation Guide.

5. Ensure that you can connect to WebSphere Commerce Payments from the
WebSphere Commerce Studio machine by opening the following URL:
http://host_name:5432/webapp/PaymentManager

or
https://host_name:5433/webapp/PaymentManager

where the variables are defined as follows:

host_name
The fully qualified TCP/IP host name of the Web server associated
with WebSphere Commerce Payments. In this case, it would be the
same host name as the WebSphere Commerce Payments machine.

If WebSphere Commerce Payments is SSL-enabled, use the secure (https)
URL. Otherwise, use the non-secure (http) URL.

If you see the IBM WebSphere Commerce Payments Logon page, your
configuration of the remote WebSphere Commerce Payments machine was
successful.

Configuring a WebSphere Commerce Studio instance to use a remote
WebSphere Commerce Payments
To configure your instance to use a remote WebSphere Commerce Payments,
do the following on your WebSphere Commerce Studio machine:
1. If you are running WebSphere Commerce in the WebSphere test
environment, stop WebSphere Commerce. For detailed instructions, refer
to [“Stopping WebSphere Commerce” on page 83
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2.

3.

Start Configuration Manager. For detailed instructions, refer to |”Startin§;|
[WebSphere Commerce Configuration Manager” on page 81)

In the navigation area, expand WebSphere Commerce » host_name »
Commerce » InstanceList » instance_name » InstanceProperties, then select
Payments.

where host_name is the TCP/IP host name of the machine running
WebSphere Commerce Studio and instance_name is the name of WebSphere
Commerce Studio instance. The default WebSphere Commerce Studio
instance is Demo_Dev.

Fill in the fields on the Payments page as follows:

Hostname
Enter the fully qualified host name of the WebSphere Commerce
Payments machine. This field defaults to the WebSphere
Commerce Studio host name. If you have installed WebSphere
Commerce Payments on a remote machine, you must ensure that
this field contains the fully qualified host name of the WebSphere
Commerce Payments machine. If WebSphere Commerce Payments
and the Web server it uses are on separate machines then enter the
fully qualified host name of the Web server machine.

Profile Path
The full path name of the directory where the standard WebSphere
Commerce WebSphere Commerce Payments Cashier Profiles are to
be stored. The default value is:

WCStudio_installdir/Commerce/instances/instance_name/xm1/payment

where instance_name is the name of WebSphere Commerce Studio
instance.

Use non-SSL Payments Client
Select this check box if you want WebSphere Commerce Studio to
use the non-Secure Sockets Layer (SSL) WebSphere Commerce
Payments client to communicate with the WebSphere Commerce
Payments server. This allows the WebSphere Commerce Server in
the WebSphere test environment to communicate with WebSphere
Commerce Payments without using SSL.

Webserver Port
Enter the TCP port number of the Web server that WebSphere
Commerce Payments uses. If you have enabled Use non-SSL
WebSphere Commerce Payments client the default value for this
field is 5432. If this check box has not been selected, the default
value for this field is 5433 (the SSL port).
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Use Socks Server
Enable this check box if WebSphere Commerce Studio must go
through a socks server in order to reach WebSphere Commerce
Payments.

Socks Hostname
Enter the fully-qualified host name of your socks server. This field
is only available if the Use Socks Server check box is enabled.

Socks Port Number
Enter the port number that your socks server uses. This field is
only available if the Use Socks Server check box is enabled.

5. Click Apply. If the changes are applied successfully, a message displays.
Click OK to dismiss the message.

6. Stop Configuration Manager. For detailed instructions, refer to[“Stopping]
[WebSphere Commerce Configuration Manager” on page 82|

Configuring accepted payment methods in WebSphere Commerce Payments

Before enabling the WebSphere Commerce Payments for use with WebSphere
Commerce in the WebSphere test environment you must configure the
payment methods accepted by a store.

When you a publish a sample store, a number of sample payment methods
are automatically configured and the instructions in this section can be
skipped. However, you should complete these steps after publishing a sample
store if you find the sample store does not contain payment methods you
would like to test.

To configure WebSphere Commerce Payments, do the following:

1. Ensure that the WebSphere Commerce Payments server is started. For
instructions on starting the WebSphere Commerce Payments server, refer
to [“Starting WebSphere Commerce Payments” on page 83/

2. Ensure that the WebSphere Commerce server is started. For instructions
on starting the WebSphere Commerce server, refer to
[WebSphere Commerce” on page 82

3. Log in to WebSphere Commerce Payments using the Site Administrator
user ID and password. You can access the WebSphere Commerce
Payments log in page by entering the following URL in a browser:

http://host_name:5432/webapp/PaymentManager

or
https://host_name:5433/webapp/PaymentManager

where the variables are defined as follows:
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10.

11.

12.

host_name
The fully qualified TCP/IP host name of the Web server
associated with WebSphere Commerce Payments. If you are
running WebSphere Commerce Payments in the WebSphere test
environment, host_name is the fully qualified TCP/IP host name
of the WebSphere Commerce Studio machine.

If WebSphere Commerce Payments is SSL-enabled, use the secure (https)
URL. Otherwise, use the non-secure (http) URL.

If you see the IBM WebSphere Commerce Payments Logon page, your
configuration of the WebSphere Commerce Payments machine was
successful.

From the left panel, click Merchant Settings.

Click Refresh to see what merchant was added after you have published
a sample store.

In the right window, click Add a Merchant.

Enter a Merchant Name for your sample store. The Merchant Number
must be the same as the storeld for your sample store (e.g. 10001). Select
the OfflineCard check box and click Create Merchant. A "Merchant
created successfully” message should appear.

Note: If a merchant already exists for your storelD, you cannot create
another merchant for the same storelD.

In the left panel, click Merchant Settings again. In the right hand
window, beside the name of your new merchant, the green cassette status
icon (under the OfflineCard column) indicates that the OfflineCard
cassette is enabled and running for that merchant. Click the green icon.
You must now create an account for each currency supported by your
store, by clicking Accounts.

Click Add an Account. Enter an Account Name and an Account Number.
The account number must be unique within that store. Select the
appropriate currency from the drop-down menu. Click Create Account.

In the Accounts window, click the name of your new account, then click
Brands.

Click Add a Brand. Enter a Brand Name (e.g. VISA) and click Create
Brand.

Repeat for all other Brands to be used with this account. Repeat the
above three steps to add accounts for all other currencies to be supported
by your store.
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Chapter 14. Configuring WebSphere Studio Application
Developer logging tools

To use the logging tools available in WebSphere Studio Application Developer
effectively with WebSphere Commerce log files, you must make the
WebSphere Commerce symptom database available to the logging tools by
importing the symptom database into WebSphere Studio Application
Developer.

To import the WebSphere Commerce symptom database into WebSphere
Studio Application Developer, do the following:

1.

10.

Start WebSphere Commerce Studio by selecting Start + Programs » IBM
WebSphere Commerce Studio »+ WebSphere Commerce development
environment.

From the Window menu, select Preferences. The Preferences dialog
opens.

In the navigation tree, expand Profiling and Logging + Activity Log then
select Symptom Database. The Symptom Database view displays.

In the Symptom Database view, click the URLs tab.
Click Add URL. The Add URL dialog opens.
Complete the fields in the Add URL dialog as follows:

Symptom database name
WebSphere Commerce

URL

|ftp://ftp.software.ibm.com/software/websphere/info/tools/|
|Toganalyzer/symptoms/wc/symptomdb . xml|

This URL is shown on multiple lines for display purposes only.
Enter the URL as one line.

Click Apply and then OK to close the dialog.
From the File menu, select Import. The Import wizard starts.

In the Import wizard, select Symptom Database File and click Next. The
Import Symptom Database File wizard starts.

Complete the remaining fields of the Import Symptom Database File
wizard as follows:
Location

LogAnalyzerProject

File
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ftp://ftp.software.ibm.com/software/websphere/info/tools/loganalyzer/symptoms/wc/symptomdb.xml
ftp://ftp.software.ibm.com/software/websphere/info/tools/loganalyzer/symptoms/wc/symptomdb.xml

wcsymptomdb. trcdbxmi
11. Click Finish to import the WebSphere Commerce symptom database file.
12. Click OK to dismiss the Preferences dialog.
The WebSphere Commerce symptom database is now available to the logging
tools in WebSphere Studio Application Developer. For more information on
the logging tools and how to use them, refer to the WebSphere Studio
Application Developer online help.
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Chapter 15. Publishing a sample store in WebSphere
Commerce Studio

To publish a sample store in WebSphere Commerce Studio, follow the
instructions in the "Publishing a store archive” topic in the WebSphere
Commerce Production and Development online help.

For more information on the sample stores, refer to WebSphere Commerce
Sample Store Guide.

For instructions on accessing the WebSphere Commerce Production and
Development online help, refer to[“WebSphere Commerce Studio online help”]

Note: If you refer to instructions for multiple platforms in the [“WebSphere
[Commerce Studio online help” on page 103 ensure you follow the

instructions for WebSphere Commerce Studio. When a help page
contains information for multiple platforms, information specific to
WebSphere Commerce Studio is indicated with the following icon:

Developer

If information specific to WebSphere Commerce Studio is not available,
ensure you follow instructions specific to Windows. When a help page
contains instructions for multiple platforms, instructions for Windows
are indicated with the following icon:
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Chapter 16. Configuring additional WebSphere Commerce
software for WebSphere Commerce Studio

WebSphere Commerce provides additional software packages that you may
want to use in the WebSphere test environment. For more information on the
additional software packages provided with WebSphere Commerce, refer to
WebSphere Commerce Additional Software Guide.

Use the information in this section, along with WebSphere Commerce Additional
Software Guide, to install and configure the additional software packages for
use with WebSphere Commerce Studio.

Using Lightweight Directory Access Protocol with WebSphere Commerce Studio

To use Lightweight Directory Access Protocol (LDAP) with WebSphere
Commerce Studio, follow the instructions for using LDAP with WebSphere
Commerce found in WebSphere Commerce Additional Software Guide with the
following changes:

¢ Launch the WebSphere Commerce Configuration Manager from within
WebSphere Studio Application Developer by following the instructions in
[‘Starting WebSphere Commerce Configuration Manager” on page 81)

IBM DB2 Text Extender

To install and configure IBM DB2 Text Extender for use with WebSphere
Commerce Studio, follow the instructions in WebSphere Commerce Additional
Software Guide.

WebSphere Commerce Analyzer

To use WebSphere Commerce Analyzer with WebSphere Commerce Studio, do
the following:

1. Enable the administration console in WebSphere Commerce Studio for the
WebSphere Commerce application server by following the instructions in
[“Enabling the administration console” on page 89

2. Follow the instructions found in WebSphere Commerce Additional Software
Guide with the following changes:

* Launch the WebSphere Commerce Configuration Manager from within
WebSphere Studio Application Developer by following the instructions
in |“Starting WebSphere Commerce Configuration Manager” on page 81
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* Launch WebSphere Commerce according to the instructions in
land stopping WebSphere Commerce” on page 82

* Launch the administration console from within WebSphere Commerce
Studio by following the instructions in [‘Starting the administration|
|console” on page 89|instead of opening the WebSphere Application
Server Administrative Console.

* Scope changes to the WebSphere Commerce application server by
selecting Server from list of available scopes.

You cannot scope any changes to the WebSphere Commerce application
server by entering the name of the WebSphere Commerce application
server in the Server field as this field is unavailable when the
WebSphere Application Server Administrative Console runs in the
WebSphere test environment.

WebSphere Commerce Version 5.5 Recommendation Engine powered by
LikeMinds

When using WebSphere Commerce 5.5 Recommendation Engine powered by
LikeMinds with WebSphere Commerce Studio, the LikeMinds server must be
installed on a machine remote from WebSphere Commerce Studio. To install
and configure WebSphere Commerce 5.5 Recommendation Engine powered by
LikeMinds for use with WebSphere Commerce Studio, follow the instructions
in WebSphere Commerce Additional Software Guide with the following exceptions:

¢ LikeMinds Personalization Server must be installed on a machine remote
from the WebSphere Commerce Studio machine.

* Launch the WebSphere Commerce Configuration Manager from within
WebSphere Studio Application Developer by following the instructions in
[‘Starting WebSphere Commerce Configuration Manager” on page 81/

To install and configure the LM Admin Console and the MovieSite sample
application, do the following:

1. Enable the administration console in WebSphere Commerce Studio for the
WebSphere Commerce application server by following the instructions in
[“Enabling the administration console” on page 89

2. Follow the instructions in the WebSphere Commerce Additional Software Guide
with the following exceptions:

 Skip any steps for starting WebSphere Application Server. Starting
WebSphere Application Server is not required when working in
WebSphere Commerce Studio.

* Skip any steps for starting the WebSphere Application Server node
agent. Starting the WebSphere Application Server node agent is not
required when working in WebSphere Commerce Studio.
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¢ Launch the administration console from within WebSphere Commerce
Studio by following the instructions in [“Starting the administration|
[console” on page 89|instead of opening the WebSphere Application
Server Administrative Console.

e For WC _Installdir use WCStudio installdir/Commerce.

Default values for WCStudio_installdir are listed in|“Path variables” on|
* For WAS Installdir use WSAD_installdir/runtimes/base_v5.

Default values for WSAD_installdir are listed in[“Path variables” on page]

WebSphere Commerce collaboration features

Customer care

To use customer care with WebSphere Commerce Studio, follow the
instructions found in WebSphere Commerce Additional Software Guide with the
following changes:

* Launch the WebSphere Commerce Configuration Manager from within
WebSphere Studio Application Developer by following the instructions in
[‘Starting WebSphere Commerce Configuration Manager” on page 81]

Collaborative workspaces

To use collaborative workspaces with WebSphere Commerce Studio, follow
the instructions found in WebSphere Commerce Additional Software Guide with
the following changes:

* Launch the WebSphere Commerce Configuration Manager from within
WebSphere Studio Application Developer by following the instructions in
[Starting WebSphere Commerce Configuration Manager” on page 81)

WebSphere Commerce business integration

The business integration software packages described in the WebSphere
Commerce Additional Software Guide, WebSphere MQ and IBM CrossWorlds®,
are not provided with either WebSphere Commerce or WebSphere Commerce
Studio. They must be purchased separately.

WebSphere MQ

To use WebSphere MQ (formerly MQSeries®) with WebSphere Commerce

Studio, do the following;:

1. If you have not already done so, repackage the adapter JAR files. For
instructions, refer to[“Repackaging WebSphere Commerce adapter JAR|
ffiles” on page 44 This step is not required if you are using WebSphere
Studio Application Developer, Version 5.0.1 or higher.
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2. Enable the administration console in WebSphere Commerce Studio for the
WebSphere Commerce application server by following the instructions in
[“Enabling the administration console” on page 89

3. Follow the instructions found in WebSphere Commerce Additional Software
Guide with the following changes:

 Skip any steps for starting WebSphere Application Server. Starting
WebSphere Application Server is not required when working in
WebSphere Commerce Studio.

* Skip any steps for starting the WebSphere Application Server node
agent. Starting the WebSphere Application Server node agent is not
required when working in WebSphere Commerce Studio.

* Launch the administration console from within WebSphere Commerce
Studio by following the instructions in [“Starting the administration|
[console” on page 89|instead of opening the WebSphere Application
Server Administrative Console.

* Scope changes to the WebSphere Commerce application server by
selecting Server from list of available scopes.

You cannot scope any changes to the WebSphere Commerce application
server by entering the name of the WebSphere Commerce application
server in the Server field as this field is unavailable when the
WebSphere Application Server Administrative Console runs in the
WebSphere test environment.

* Do not perform the tasks outlined in "Determining the maximum
number of ManagedConnections for the JCA-JMS connector”.

* Do not change the value in the Max Connections field of the
Connection Pool page for the WebSphere MQ JMS Provider queue
connection factory in the administration console. Accept the default
value.

* Launch the WebSphere Commerce Configuration Manager from within
WebSphere Studio Application Developer by following the instructions
in [“Starting WebSphere Commerce Configuration Manager” on page 81

IBM CrossWorlds

To use IBM CrossWorlds with WebSphere Commerce Studio, do the following:

1. If you have not already done so, repackage the adapter JAR files. For
instructions, refer to|“Repackaging WebSphere Commerce adapter JAR|
ffiles” on page 44.|

2. Enable the administration console in WebSphere Commerce Studio for the
WebSphere Commerce application server by following the instructions in
[“Enabling the administration console” on page 89

3. Follow the instructions found in WebSphere Commerce Additional Software
Guide with the following changes:

* Replace all occurrences of WC_installdir with WCStudio_installdir.
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* When tasks refer to the WebSphere Commerce machine, use the
WebSphere Commerce Studio machine.

* Skip any steps for starting WebSphere Application Server. Starting
WebSphere Application Server is not required when working in
WebSphere Commerce Studio.

¢ Launch the administration console from within WebSphere Commerce
Studio by following the instructions in [‘Starting the administration|
[console” on page 89|instead of opening the WebSphere Application
Server Administrative Console.

* Launch the WebSphere Commerce Configuration Manager from within
WebSphere Studio Application Developer by following the instructions
in|“Starting WebSphere Commerce Configuration Manager” on page 81

* Scope changes to the WebSphere Commerce application server by
selecting Server from list of available scopes.

You cannot scope any changes to the WebSphere Commerce application
server by entering the name of the WebSphere Commerce application
server in the Server field as this field is unavailable when the
WebSphere Application Server Administrative Console runs in the
WebSphere test environment.
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Chapter 17. Advanced configurations for WebSphere
Commerce Studio

The development environment installed by WebSphere Commerce Studio is
best suited for developing a single store within a single WebSphere Commerce
Studio instance in a single workspace. IBM does not recommend having
multiple WebSphere Commerce Studio instances in one workspace.

Creating a WebSphere Commerce Studio instance

To create a WebSphere Commerce Studio instance, do the following:

1.

2.

Start WebSphere Commerce Configuration Manager. For details, refer to
[‘Starting WebSphere Commerce Configuration Manager” on page 81

In the navigation area, select WebSphere Commerce » host_name
Commerce » InstanceList.

where host_name is the TCP/IP host name of the machine running
WebSphere Commerce Studio.

Select Action » Create instance. The Instance Creation wizard starts.

Complete the Instance Creation wizard. For help on completing the panels
and fields in the Instance Creation wizard, click Help on the Instance
Creation wizard.

The help for the Instance Creation wizard is common for all platforms. If a
field requires information unique to WebSphere Commerce Studio, the
information is indicated with this icon:

Developer

If information specific to WebSphere Commerce Studio is not indicated,
use information specific to Windows. Instructions for Windows are
indicated with the following icon:

Information not marked with any icon applies to all platforms equally,
including WebSphere Commerce Studio.

When you have completed all the necessary information in all the panels,
the Finish button is enabled. Click Finish to create the WebSphere
Commerce Studio instance.

You are asked if you want to populate the Oracle database. Select
Yes if you want your database to be populated, or No if you do not want
your database to be populated.

Depending on the speed of your system, it will take several minutes to
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several hours for your instance to be created. The progress bar that displays

when you start creating the instance will indicate when the process has

finished.

7. When instance creation is complete, a dialog appears containing a
summary. Click OK to dismiss the dialog.

8. Stop Configuration Manager. For detailed instructions, refer to|”Stopping|
[WebSphere Commerce Configuration Manager” on page 82|

9. Verify the creation of the WebSphere Commerce Studio instance by
following the instructions in [“Verifying theWebSphere Commerce Studid
finstance creation.”]

Verifying theWebSphere Commerce Studio instance creation

To verify that the instance has been properly created, check the following files
in the WCStudio_installdir\Commerce\instances\WCStudio instance_name
directory:

\xm1\WCStudio_instance_name .xm]
This file contains all of the configuration information about the
WebSphere Commerce Studio instance.

\Togs\createdb.log
This file contains information about the WebSphere Commerce Studio
database creation.

\Togs\populatedb.log
This file contains information about the WebSphere Commerce Studio
database population process .

\logs\sec_check.log
This file contains information about potential security exposures.

The default value for WCStudio_installdir is listed in |[“Path variables” on page]

Creating a WebSphere Commerce Payments instance

To create a WebSphere Commerce Payments instance, do the following;:

1. Start WebSphere Commerce Configuration Manager. For details, refer to
[‘Starting WebSphere Commerce Configuration Manager” on page 81)

2. In the navigation area, select WebSphere Commerce » host_name -
Payments » InstanceList.

where host_name is the TCP/IP host name of the machine running
WebSphere Commerce Studio.

3. Select Action » Create payments instance. The payments instance creation
wizard starts.
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4. Complete the payments instance wizard information. For help on
completing the panels and fields in the instance creation wizard, click
Help on the payments instance creation wizard.

The help for the payments instance creation wizard is common for all

platforms. If a field requires information unique to WebSphere Commerce
Studio, the information is indicated with this icon:

Developer

If information specific to WebSphere Commerce Studio is not indicated,
use information specific to Windows. Instructions for Windows are
indicated with the following icon:

Information not marked with any icon applies to all platforms equally,
including WebSphere Commerce Studio.
5. When you have completed all the necessary information in all the panels,

the Finish button is enabled. Click Finish to create the WebSphere
Commerce Payments instance.

6. You are asked if you want to populate the Oracle database. Select
Yes if you want your database to be populated, or No if you do not want
your database to be populated.

Depending on the speed of your system, it will take several minutes to

several hours for your instance to be created. The progress bar that displays

when you start creating the instance will indicate when the process has

finished.

7. When instance creation is complete, a dialog appears containing a
summary of the instance creation. Click OK to dismiss the dialog.

8. Stop Configuration Manager. For detailed instructions, refer tol”Stoppingl
[WebSphere Commerce Configuration Manager” on page 82/

9. Verify the creation of the WebSphere Commerce Payments instance by
following the instructions in [“Verifying the WebSphere Commerce]
[Payments instance creation.”

To use the new WebSphere Commerce Payments instance with WebSphere
Commerce Studio, refer to [Chapter 13, “Configuring payment processing in|
[WebSphere Commerce Studio,” on page 53]

Verifying the WebSphere Commerce Payments instance creation

To verify that the instance has been properly created, check the following files
in the WCStudio_installdir\Commerce\instances\payments_instance_name
directory:
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\xm1\payments_instance_name .xml

This file contains all of the configuration information about your
WebSphere Commerce Payments instance.

\Togs\createdb.log

This file contains information about the WebSphere Commerce
Payments database creation.

The default value for WCStudio_installdir is listed in|“Path variables” on pagel

Deleting a WebSphere Commerce Studio instance

To delete a WebSphere Commerce Studio instance, do the following:

1.

2.

9.

Stop WebSphere Commerce. For details, refer to|“Stopping WebSphere|
[Commerce” on page 83|

Start WebSphere Commerce Configuration Manager. For details, refer to
[‘Starting WebSphere Commerce Configuration Manager” on page 81

In the navigation area, select WebSphere Commerce » host_name
Commerce » InstanceList » instance_name.

where host_name is the TCP/IP host name of the machine running
WebSphere Commerce Studio and instance_name is the name of the
WebSphere Commerce Studio instance you want to delete.

Select Action » Delete instance. A confirmation dialog displays.

Click Yes to delete the WebSphere Commerce Studio instance. If the
instance deletes successfully, a message displays. Click OK to dismiss the
message.

Stop Configuration Manager. For detailed instructions, refer to |”Stoppiné|
[WebSphere Commerce Configuration Manager” on page 82.|

Drop the WebSphere Commerce Studio database by following the
instructions in ["Dropping a database” on page 76

Delete the files associated with the deleted WebSphere Commerce Studio
instance by deleting the following directory:

WCStudio_installdir\Commerce\instances\instance name

where instance_name is the name of the deleted WebSphere Commerce
Studio instance and the default value for WCStudio_installdir is listed in
[“Path variables” on page v

S Delete the following directory, if it exists:
DB2 installdir\function\routine\sqlproc\database name
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10.

database_name is the name of the database for the deleted WebSphere
Commerce Studio instance. Default values for DB2_installdir are listed in
[“Path variables” on page v

If you published any stores in the WebSphere Commerce Studio instance,
remove the store files by deleting the following directory:

WCStudio_workspacedir\Stores\Web Content\store_name

where WCStudio_workspacedir is the directory associated with the
workspace for the instance and store_name is the name of the store. The
default workspace directories are listed in [“Path variables” on page v/

Deleting a WebSphere Commerce Payments instance

To delete a WebSphere Commerce Payments instance, do the following:

1.

Stop WebSphere Commerce Payments. For details, refer to pping
[WebSphere Commerce Payments” on page 85

Start WebSphere Commerce Configuration Manager. For details, refer to
[‘Starting WebSphere Commerce Configuration Manager” on page 81

In the navigation area, select WebSphere Commerce » host_name
Payments » Instance List » instance_name.

where host_name is the TCP/IP host name of the machine running
WebSphere Commerce Studio and instance_name is the name of WebSphere
Commerce Payments instance you want to delete.

Select Action » Delete Payments instance. A confirmation dialog displays.
Click Yes to delete the WebSphere Commerce Payments instance. If the

instance deletes successfully, a message displays. Click OK to dismiss the
message.

Stop Configuration Manager. For detailed instructions, refer tol”Stoppingl
[WebSphere Commerce Configuration Manager” on page 82

Drop the WebSphere Commerce Payments database by following the
instructions in [“Dropping a database” on page 76.|

Delete the file associated with the deleted WebSphere Commerce Payments
instance by deleting the following directories, if they exist:

WCStudio_installdir\Commerce\instances\instance_name
WCStudio_installdir\Commerce\payments\instance_name

where instance_name is the name of the deleted WebSphere Commerce
Payments instance and the default value for WCStudio_installdir is listed in
[“Path variables” on page v/

S Delete the following directory, if it exists:
DB2 installdir\function\routine\sqlproc\database name
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database_name is the name of the database for the deleted WebSphere
Commerce Studio instance. Default values for DB2_installdir are listed in
[“Path variables” on page v

Dropping a database

Follow the instructions appropriate to your WebSphere Commerce Studio
configuration:

* ['Dropping a local database in DB2 Universal Database”|

* ["'Dropping a remote database in DB2 Universal Database”|

* ['Dropping the WebSphere Commerce Studio database on Oracle9i|
Database” on page 77|

Dropping a local database in DB2 Universal Database
To drop a local database in DB2 Universal Database, do the following:

1. Open a DB2 command window by selecting Start » Programs » IBM DB2
+» Command Line Tools »* Command Line Processor.

2. Enter the following command:
drop db database_name

where database_name is the name of the database for the deleted
WebSphere Commerce Studio or WebSphere Commerce Payments instance.
Dropping a remote database in DB2 Universal Database
To drop a remote database in DB2 Universal Database, do the following:

1. Open a DB2 command window on the WebSphere Commerce Studio
machine by selecting Start + Programs » IBM DB2 + Command Window.

2. Enter the following commands:

attach to node_name user db2 _admin_id using db2 admin_password
drop db database_name
uncatalog node node_name

where
e node_name is the name of the node for the database_name.

e db2_admin_id is the DB2 database administrator ID on the remote
database.

* db2_admin_password is the password for the DB2 database administrator
ID on the remote database.

* database_name is the name of the database for the deleted WebSphere
Commerce Studio or WebSphere Commerce Payments instance.
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Dropping the WebSphere Commerce Studio database on Oracle9i

Database

Dropping the WebSphere Commerce Studio database is not required for

Oracle9i Database when deleting the WebSphere Commerce Studio instance.

Instead, you must delete the tablespaces, datafiles and Oracle IDs for the
instances. The following table summarizes the tablespaces and datafiles you
must delete when deleting a WebSphere Commerce Studio or WebSphere
Commerce Payments instance:

Database Default Default full path to datafile
tablespace name

WebSphere WCTBLSPC drive:\oracle\ora92\database\wcs.dbf

Commerce

WebSphere WPMTBLSPC drive:\oracle\ora92\database\wpm.dbf

Commerce

Payments

For information on deleting tablespaces, datafiles, and Oracle IDs, refer to the
Oracle9i Database documentation.
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Part 4. Appendixes
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Appendix A. WebSphere Commerce Studio tasks

This section provides instructions on some common tasks performed while
installing, configuring, and using WebSphere Commerce Studio. The tasks
covered in this section are:

* [‘Starting and stopping WebSphere Commerce Configuration Manager.”]

* [‘Starting and stopping WebSphere Commerce” on page 82|

* [‘Starting and stopping WebSphere Commerce Payments” on page 83

* [‘Opening the WebSphere Commerce Administration Console” on page 87

* ["Opening the WebSphere Commerce Organization Administration Console’]

on page 87.|

* ["Opening the WebSphere Commerce Payments user interface” on page 88|

* [‘Opening the WebSphere Commerce Accelerator” on page 88

[‘Enabling the administration console” on page 89

[‘Starting the administration console” on page 89.|

* [Importing a project manually” on page 90/

Starting and stopping WebSphere Commerce Configuration Manager

Many settings in the WebSphere Commerce Studio instance are set using the
WebSphere Commerce Configuration Manager. The instructions in this section
are for starting and stopping WebSphere Commerce in the WebSphere test
environment. For instructions on starting and stopping WebSphere Commerce
in WebSphere Application Server, refer to WebSphere Commerce Installation
Guide.

Starting WebSphere Commerce Configuration Manager

To start the WebSphere Commerce Configuration Manager, do the following:

1. Start WebSphere Commerce Studio by selecting Start » Programs » IBM
WebSphere Commerce Studio + WebSphere Commerce development
environment.

2. Show the WebSphere Commerce view in WebSphere Studio Application
Developer by doing the following:
a. Open the Show View dialog by selecting Window » Show View -
Other.
b. In the Show View dialog, expand Other and select WebSphere
Commerce.

c. Click OK to dismiss the Show View dialog and display the WebSphere
Commerce view.
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This adds the WebSphere Commerce view to the Show View menu. In the
future, to show the WebSphere Commerce view, select Window *» Show
View » WebSphere Commerce.

3. In the WebSphere Commerce view, right-click Configuration Manager
Server and select Start server from the pop-up menu.

4. When the status of the Configuration Manager Server is "Started”,
right-click Configuration Manager Server again and select Run client
from the pop-up menu. The Configuration Manager client displays.

Stopping WebSphere Commerce Configuration Manager
To stop the WebSphere Commerce Configuration Manager from WebSphere
Commerce Studio, do the following:
1. Exit the WebSphere Commerce Configuration Manager by selecting
Console » Exit.
2. Go to the WebSphere Commerce view in WebSphere Studio Application
Developer by doing the following:
a. Open the Show View dialog by selecting Window » Show View -
Other.
b. In the Show View dialog, expand Other and select WebSphere
Commerce.
c. Click OK to dismiss the Show View dialog and display the WebSphere
Commerce view.

This adds the WebSphere Commerce view to the Show View menu. In the
future, to show the WebSphere Commerce view, select Window » Show
View » WebSphere Commerce.

3. In the WebSphere Commerce view, right-click Configuration Manager
Server and select Stop server from the pop-up menu.

Starting and stopping WebSphere Commerce

The instructions in this section are for starting and stopping WebSphere
Commerce in the WebSphere test environment. For instructions on starting
and stopping WebSphere Commerce in WebSphere Application Server, refer to
WebSphere Commerce Installation Guide.

Starting WebSphere Commerce

To start WebSphere Commerce in the WebSphere test environment, start the

WebSphere Commerce application server by doing the following:

1. Start WebSphere Commerce Studio by selecting Start » Programs +» IBM
WebSphere Commerce Studio »* WebSphere Commerce development
environment.

2. In the Servers view, right-click WebSphereCommerceServer and select Start
from the pop-up menu.
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Check the Console view to ensure that no errors occur as the WebSphere
Commerce application server starts.

The WebSphere Commerce application server is started successfully if the
following message appears in the Console view:

Server serverl open for e-business

However, a successful start of the WebSphere Commerce application server
does not indicate that WebSphere Commerce started successfully in the
WebSphere test environment. To ensure that WebSphere Commerce started
successfully, review the contents of the Console view to ensure that no errors
occurred. If the Console view contains no error messages, WebSphere
Commerce started successfully.

Stopping WebSphere Commerce
To stop WebSphere Commerce in the WebSphere test environment, stop the
WebSphere Commerce application server by doing the following:
1. Start WebSphere Commerce Studio by selecting Start » Programs » IBM
WebSphere Commerce Studio + WebSphere Commerce development
environment.

2. In the Servers view, right-click WebSphereCommerceServer and select Stop
from the pop-up menu.

Check the Console view to ensure that the WebSphere Commerce application
server stops.

Starting and stopping WebSphere Commerce Payments

The instructions in this section are for starting and stopping WebSphere
Commerce Payments in the WebSphere test environment. For instructions on
starting and stopping WebSphere Commerce Payments in WebSphere
Application Server, refer to WebSphere Commerce Installation Guide.

Starting WebSphere Commerce Payments

To start WebSphere Commerce Payments, do the following;:

1. (Optional) Check if the WebSphere Commerce Payments instance
password is required. For instructions, refer to |“Checking if the WebSphere|
[Commerce Payments instance password is required” on page 86.|

By default, the WebSphere Commerce Payments instance created during
the installation of WebSphere Commerce Studio does not require the
WebSphere Commerce Payments instance password.

You should check if the instance password is required if you are unsure of
the setting.
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2. Start the WebSphere Commerce Payments application server in the
WebSphere test environment. For instructions, refer to |”Starting tha
[WebSphere Commerce Payments application server.”|

3. If the WebSphere Commerce Payments instance password is required,
issue the IBMPayServer command. For details, refer to

[BMPayServer command.”|

Starting the WebSphere Commerce Payments application server
To start the WebSphere Commerce Payments application in the WebSphere

test environment, start the WebSphere Commerce Payments application server

by doing the following:

1. Start WebSphere Commerce Studio by selecting Start »+ Programs » IBM
WebSphere Commerce Studio »+ WebSphere Commerce development
environment.

2. In the Servers view, right-click WebSphereCommercePaymentsServer and
select Start from the pop-up menu.

Check the Console view to ensure that no errors occur as the WebSphere
Commerce Payments application server starts.

The WebSphere Commerce Payments application server is started successfully
if the following message appears in the Console view:

Server serverl open for e-business

However, a successful start of the WebSphere Commerce Payments
application server does not indicate that the WebSphere Commerce Payments
application started successfully in the WebSphere test environment. To ensure
that the WebSphere Commerce Payments application started successfully,
review the contents of the Console view to ensure that no errors occurred. If
the Console view contains no error messages, the WebSphere Commerce
Payments application started successfully.

Issuing the IBMPayServer command
The IBMPayServer command is used to specify the WebSphere Commerce

Payments password for connecting to the database and decrypting any
sensitive data that is stored in the database. For more information on the
WebSphere Commerce Payments password, refer to [“WebSphere Commerce
[Payments instance password” on page 86|

To issue the IBMPayServer command, do the following:

1. Open a command prompt.

2. Change directories to the following directory:
WCStudio_installdir\Commerce\payments\bin
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The default value for WCStudio_installdir is listed in [“Path variables” onl|

3. Issue the following command:
IBMPayServer instance_name

where instance_name is the name of the WebSphere Commerce Payments
instance that you want to start. The name of the default WebSphere
Commerce Payments instance is wpm.

At the Password prompt, enter the password associated with the database
user ID for the WebSphere Commerce Payments database.
Stopping WebSphere Commerce Payments
To stop WebSphere Commerce Payments, do the following:

1. (Optional) Check if the WebSphere Commerce Payments instance
password is required. For instructions, refer to|’Checking if the WebSphere|
[Commerce Payments instance password is required” on page 86.|

By default, the WebSphere Commerce Payments instance created during
the installation of WebSphere Commerce Studio does not require the
WebSphere Commerce Payments instance password.

You should check if the instance password is required if you are unsure of
the setting.

2. If the WebSphere Commerce Payments instance password is required
issue the StopIBMPayServer command. For more details, refer to
fthe StopIBMPayServer command.”|

3. Stop the WebSphere Commerce Payments application server in the
WebSphere test environment. For instructions, refer to |”Stopping tha
[WebSphere Commerce Payments application server” on page 86|

Issuing the StopIBMPayServer command
To issue the StopIBMPayServer command, do the following;:

1. Open a command prompt.
2. Change directories to the following directory:
WCStudio_installdir\Commerce\payments\bin

where the default value for WCStudio_installdir is listed in [“Path variables”]

3. Issue the following command:

StopIBMPayServer instance_name

where instance_name is the name of the WebSphere Commerce Payments
instance that you want to stop.
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At the Password prompt, enter the password associated with the database
user ID for the WebSphere Commerce Payments database.

Stopping the WebSphere Commerce Payments application server
To stop the WebSphere Commerce Payments application server in the

WebSphere test environment, do the following;:

1. Start WebSphere Commerce Studio by selecting Start » Programs +» IBM
WebSphere Commerce Studio »+ WebSphere Commerce development
environment.

2. In the Servers view, right-click WebSphereCommercePaymentsServer and
select Stop from the pop-up menu.

Check the Console view to ensure that the WebSphere Commerce Payments
application server stops.

WebSphere Commerce Payments instance password

WebSphere Commerce Payments requires a password so that it can decrypt
any sensitive data that is stored in the database. Protection of this password is
therefore critical to protecting the security of your payment data. The
IBMPayServer command is used to specify the WebSphere Commerce
Payments instance password. The password is also required when issuing the
StopIBMPayServer command.

The password is the WebSphere Commerce Payments instance password
defined when the WebSphere Commerce Payments instance was created.

You must specify the password directly from the command line after issuing
the IBMPayServer or StopIBMPayServer command.

Checking if the WebSphere Commerce Payments instance password is
required

By default, the WebSphere Commerce Payments instance created during the
installation of WebSphere Commerce Studio does not require the WebSphere
Commerce Payments instance password. You should check if the instance
password is required if you are unsure of the setting.

To check if the WebSphere Commerce Payments instance password is required

when starting WebSphere Commerce Payments from a command line, do the

following:

1. Open the Configuration Manager. For instruction, refer to |”Starting|
[WebSphere Commerce Configuration Manager” on page 81|

2. Expand your host name.
3. Expand Payments.
4. Expand Instance List.
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5. Expand the name of the WebSphere Commerce Payments instance you
want to start. The default WebSphere Commerce Payments instance is wpm.

6. Expand Instance Properties.
7. Select Instance.

If the Password Required for startup check box is selected, you must issue
the IBMPayServer command after starting the WebSphere Commerce Payments
application server and you must issue the StopIBMPayServer command before
stopping the WebSphere Commerce Payments application server.

Opening the WebSphere Commerce Administration Console

TheWebSphere Commerce Administration Console allows you to control your
site or store by completing administrative operations and configuration tasks.
If you are authorized to work with multiple stores and languages, you select
the store and language with which you want to work when you log on to the
Administration Console. The tasks that you are authorized to perform display
on the Administration Console home page through various menus. These
tasks are based on the user group names (roles) and authority levels.

The WebSphere Commerce Administration Console is not accessible from the
browser that is part of WebSphere Studio Application Developer. To open the
WebSphere Commerce Administration Console, do the following:

1. Ensure that WebSphere Commerce is started. For instructions on starting
WebSphere Commerce, refer to [’Starting WebSphere Commerce” on page]

Q
[

2. Open Internet Explorer and access the following URL:

https://hostname/webapp/wcs/admin/serviet/
ToolsLogon?XMLFile=adminconsole.AdminConsolelLogon

where hostname is the fully-qualified TCP/IP host name of the WebSphere
Commerce Studio machine.

The URL is shown on multiple lines for display purposes only. Enter the
URL as a single line.

Opening the WebSphere Commerce Organization Administration Console

The WebSphere Commerce Organization Administration Console allows you,
and the buyer’s administrators to control the organizations that access your
site or store. The tasks that you are authorized to perform display on the
Organization Administration Console home page through various menus.
These tasks are based on the user roles and authority levels.
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The WebSphere Commerce Organization Administration Console is not
accessible from the browser that is part of WebSphere Studio Application
Developer. To open WebSphere Commerce Organization Administration
Console, do the following:

1. Ensure that WebSphere Commerce is started. For instructions on starting
WebSphere Commerce, refer to [“Starting WebSphere Commerce” on page|

82
2. Open Internet Explorer and access the following URL:

https://hostname/webapp/wcs/orgadmin/serviet/
ToolsLogon?XMLFile=buyerconsole.BuyAdminConsolelLogon

where hostname is the fully-qualified TCP/IP host name of the WebSphere
Commerce Studio machine.

The URL is shown on multiple lines for display purposes only. Enter the
URL as a single line.

Opening the WebSphere Commerce Accelerator

The WebSphere Commerce Accelerator allows you to maintain online stores
by completing various store operations — from managing the look and feel of
your store to creating and maintaining orders to tracking store activities.

The WebSphere Commerce Accelerator is not accessible from the browser that
is part of WebSphere Studio Application Developer. To open WebSphere
Commerce Accelerator, do the following:

1. Ensure that WebSphere Commerce is started. For instructions on starting
WebSphere Commerce, refer to|“Starting WebSphere Commerce” on page]

2. Open Internet Explorer and access the following URL:

https://hostname/webapp/wcs/tools/serviet/
ToolsLogon?XMLFi1le=common.mcLogon

where hostname is the fully-qualified TCP/IP host name of the WebSphere
Commerce Studio machine.

The URL is shown on multiple lines for display purposes only. Enter the
URL as a single line.

+ Opening the WebSphere Commerce Payments user interface

+ While much of the WebSphere Commerce Payments user interface is
+ incorporated into the other WebSphere Commerce tools, you may want to
+ open the WebSphere Commerce Payments user interface on its own.
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+ 4+ + 4+ + + + +

+ +

The WebSphere Commerce Payments user interface is not accessible from the
browser that is part of WebSphere Studio Application Developer. To open the
WebSphere Commerce Payments user interface, do the following;:

1. Ensure that WebSphere Commerce Payments is started. For instructions on
starting WebSphere Commerce Payments, refer to |[“Starting WebSphere]
[Commerce Payments” on page 83

2. Open Internet Explorer and access the following URL:
http://hostname:9081/webapp/PaymentManager

Log on using the WebSphere Commerce Site Administrator ID and
password.

Enabling the administration console

Enabling the administration console for the WebSphere Commerce application
server allows you to use the WebSphere Application Server Administrative
Console to configure the WebSphere Commerce application server in the
WebSphere test environment.

To enable the administration console for the WebSphere Commerce
application server, do the following:

1. Start WebSphere Commerce Studio by selecting Start » Programs » IBM
WebSphere Commerce Studio + WebSphere Commerce development
environment.

2. In the Servers view, double-click WebSphereCommerceServer. The
WebSphereCommerceServer view displays.
3. In the WebSphereCommerceServer view, select the Configuration page.

4. On the Configuration page, select the Enable administration client check
box.

5. Save the updates to the configuration by selecting File » Save
WebSphereCommerceServer.

6. Republish the server by going to the Servers view, right-clicking
WebSphereCommerceServer, and selecting Publish from the pop-up menu.
Click OK.

Starting the administration console

Before you can start the administration console, it must be enabled in the
WebSphere Commerce application server. For instructions on enabling the
administration console in the WebSphere Commerce application server, refer
to [“Enabling the administration console.”|

To start the administration console for the WebSphere Commerce application
server, do the following:
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1. If WebSphere Commerce was running when you enabled the
administration console, stop WebSphere Commerce as described in
[‘Stopping WebSphere Commerce” on page 83/}

2. Start WebSphere Commerce according to the instructions in
[WebSphere Commerce” on page 82

3. When WebSphere Commerce has successfully started, go to the Servers
view, right-click WebSphereCommerceServer, and select Run administrative
client from the pop-up menu.

The administration console will appear in the Admin Console view.

Importing a project manually

If, during the import of the WebSphere Commerce Studio workspace, a project
fails to import, do the following:

1. Start WebSphere Commerce Studio by selecting Start * IBM WebSphere
Commerce Studio » WebSphere Commerce development environment.

2. Ensure you are in the J2EE perspective. If you cannot find the J2EE
perspective, select Window » Open Perspective » J2EE.

3. Go to the J2EE Navigator view.
4. Delete the project that failed to import by doing the following:

a. Right-click the project that failed to import and select Delete from the
pop-up menu. The Delete Module Options dialog displays.

b. In the Delete Module Options dialog, ensure that Delete selected
project(s) only is selected and click OK. The Confirm Project Delete
dialog displays.

C. In the Confirm Project Delete dialog, ensure that Do not delete
contents is selected and click Yes.

5. Import the project into the workspace by doing the following:

a. Select File » Import. The Import wizard starts.

Select Existing Project into Workspace and click Next.

On the Import Project page of the wizard, click Browse.

2 oo

In the Browse for Folder dialog, locate the folder with the same name
as the project that failed to import. Select the folder and click OK to
dismiss the dialog.

The folders for projects are located in the WebSphere Commerce Studio
workspace directory. The default workspace directory is
C:\WebSphere\workspace_db2 or C:\WebSphere\workspace oracle,
depending on the target database type you chose in the WebSphere
Commerce Studio installation wizard.

e. Click Finish.
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If the Repair Server Configuration dialog displays after clicking Finish,
ensure that WebSphereCommerceServer configuration and any entries
below it are selected and click OK.

If multiple projects failed to import, repeat these steps for each project.
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Appendix B. Recovering from installation errors

This section contains information describing how to recover from error
messages received from the WebSphere Commerce Studio installation wizard.

Merchant key is invalid

If you receive an error message indicating that the merchant key entered is
invalid, ensure that you have entered the merchant key correctly and that the
merchant key meets all the criteria listed in|’Other information required to|
fcomplete the installation wizard” on page 18]

Copying the Oracle workspace fails
If copying the WebSphere Commerce Studio Oracle workspace fails, do the
following:

1. Check that the Oracle workspace directory has been created. The default
Oracle workspace directory is C:\WebSphere\workspace_oracle.

If the Oracle workspace directory does not exist, you must reinstall
WebSphere Commerce Studio.

2. Copy the Oracle workspace file from the WebSphere Commerce Studio CD
to a temporary directory. The Oracle workspace file is in the following file
on the WebSphere Commerce Studio CD:

workspace\oracle.jar

3. Unzip the oracle.jar file to the Oracle workspace directory.

Importing the WebSphere Commerce Studio workspace fails

If importing the WebSphere Commerce Studio workspace into WebSphere
Studio Application Developer fails, check if the WebSphere Commerce Studio
workspace import log exists. The workspace import log file is located in the
following path:

WCStudio_installdir\logs\import_workspace.log

The default value for WCStudio_installdir is listed in[“Path variables” on page]

If the workspace import log file does not exist, do the following:
1. Ensure that WebSphere Studio Application Developer is not running.

2. Delete the .metadata directory from WCStudio_workspacedir. Default values
for WCStudio_workspacedir are listed in [“Path variables” on page v.|
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3. Start a command prompt session by selecting Start » Programs -
Accessories » Command Prompt.

4. Issue the following command:
WCStudio_installdir\Commerce\bin\import_workspace.bat

5. After the command finishes, check the workspace import log file to ensure
that all projects were imported successfully. If any exceptions occurred
while a project was being imported, then that project must be imported
manually. Refer to [Importing a project manually” on page 90| for
instructions on importing a project manually.

If the workspace import log file exists, follow the instructions in [“WebSpherg
[Commerce Studio workspace import log” on page 36.|

WebSphere Commerce StudioWebSphere Commerce - Express Developer
Edition instance creation fails
If the creation of the WebSphere Commerce Studio instance fails during the
installation, check if the instance directory exists. The instance directory is:
WCStudio_installdir\Commerce\instances\instance name

where instance_name is the name of the WebSphere Commerce Studio instance.
The default name of the WebSphere Commerce Studio instance is Demo Dev
and the default value for WCStudio_installdir is listed in [“Path variables” on|

If the instance directory exists, do the following:

1. Check the instance creation log files listed in [“WebSphere Commerce]
Studio instance creation logs” on page 37|to confirm that instance creation
failed.

2. If the log files confirm that instance creation failed, do the following;:

a. Drop the WebSphere Commerce Studio database by following the
instructions in [“Dropping a database” on page 76)

b. Create the WebSphere Commerce Studio instance manually by
following the instructions in [“Creating a WebSphere Commerce Studio
[instance” on page 71

If the instance directory does not exist, create the WebSphere Commerce
Studio instance manually by following the instructions in
[WebSphere Commerce Studio instance” on page 71!
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Appendix C. Known problems and limitations

This section covers known problems and limitations with WebSphere
Commerce Studio. Refer to the README file for any updates on problems or
limitations.

Installation problems and limitations

User authorization

You should log on as a user with Administration rights before beginning the
WebSphere Commerce Studio installation.

Windows Installer Internal Error 20552

If you receive error 20552 during WebSphere Studio Application Developer
installation phase of the WebSphere Commerce Studio installation, check if
you have a Web server or WebSphere Application Server running. If either of
these applications are running, shut them down.

Problems starting WebSphere Commerce in the WebSphere test environment

If you are experiencing problems starting WebSphere Commerce in the
WebSphere test environment, do the following in WebSphere Commerce
Studio:

1.

Start WebSphere Commerce Studio by selecting Start + Programs » IBM
WebSphere Commerce Studio + WebSphere Commerce development
environment.

Select Window » Preferences. The Preferences window displays.

Select Workbench and clear the Perform™ build automatically on
resource modification check box. Click Apply.

Select Validation and clear the following check boxes:
* HTML Syntax Validator

* JSP Compilation Validator

* WAR Validator

Click OK.

Restart WebSphere Commerce Studio.

Start the WebSphere Commerce Server. For instructions, refer to
[WebSphere Commerce” on page 82)
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WebSphere Commerce Studio and WebSphere Commerce coexistence

If you plan to install WebSphere Commerce Studio and WebSphere Commerce
on the same machine, they must not share any assets. Each product should
use their own database and their own instance. The following table shows the
default names of the databases and instances for WebSphere Commerce
Studio and WebSphere Commerce:

WebSphere Commerce Studio WebSphere Commerce
Commerce Demo_Dev
database Mall
name b _oracte | DemoDev
Payments
database wpm wpm
name
Instance Demo_ Dev Demo
name

If the wpm database exists during the installation of WebSphere Commerce
Studio, you must specify a different database user ID for the new wpm
database. If you use the same database user ID for both wpm databases the
creation of the WebSphere Commerce Payments instance for WebSphere
Commerce Studio will fail. The WebSphere Commerce Payments instance can
be created manually after installing WebSphere Commerce Studio by
following the instructions in|’Creating a WebSphere Commerce Payments|
finstance” on page 72

— Important
In a coexistence environment, WebSphere Commerce and WebSphere
Commerce Studio cannot be running at the same time.

If you want to use WebSphere Commerce Studio, ensure the following
applications are stopped:

* Web server
* WebSphere Commerce application server
* WebSphere Commerce Payments application server

If you want to use WebSphere Commerce, ensure that WebSphere
Commerce Studio is not running.
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Sample stores in WebSphere Commerce Studio

The following issues exist when using the sample stores provided with
WebSphere Commerce Studio:

* Multiple Direct Sales business model sample stores can be published in a
single WebSphere Commerce Studio instance.

« MM A Hosting business model sample store cannot exist in the same
WebSphere Commerce Studio instance as a Direct Sales business model
sample store or a Value Chain business model sample store. It must be the
only store in the WebSphere Commerce Studio instance.

« SEEIEN A Value Chain business model sample store cannot exist in the
same WebSphere Commerce Studio instance as a Direct Sales business
model sample store or a Hosting business model sample store. It must be
the only store in the WebSphere Commerce Studio instance.

For more information on the samples stores, refer to WebSphere Commerce
Sample Store Guide.
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Appendix D. Uninstalling WebSphere Commerce Studio

If you encounter problems installing WebSphere Commerce Studio, you may
want to uninstall one or more components and start again. This chapter
explains how to uninstall each component of WebSphere Commerce Studio.

Uninstalling WebSphere Commerce Studio

Uninstalling WebSphere Commerce Studio removes the WebSphere Commerce
Studio workspace from WebSphere Studio Application Developer. WebSphere
Studio Application Developer and DB2 Universal Database are not uninstalled
when uninstalling WebSphere Commerce Studio.

To uninstall WebSphere Commerce Studio, complete the following steps:

1.

While logged on with a Windows user ID with Administrator authority,
click Start » Settings » Control Panel + Add/Remove Programs.

Click Change or Remove Programs, select IBM WebSphere Commerce
Studio and click Change/Remove.

A window opens asking you to confirm that you want to remove the
selected programs. Click Yes to continue with the uninstall.

When the uninstall is complete, click OK.

Remove the WebSphere Commerce Studio path from the Path environment
variable by doing the following:

a.

Select Start » Settings + Control Panel » System. The System
Properties dialog opens.

b. Select the Advanced tab of the System Properties dialog.

c. Click Environment Variables. The Environment Variables window

opens.

In the System variables pane, scroll the list of variables so you can
select the Path environment variable.

After selecting the Path environment variable, click Edit.

In the Variable Value field, remove any paths containing the
WebSphere Commerce Studio installation directory. For example,
C:\WEBSP~1\COMMER 1\Commerce\bin.

The default WebSphere Commerce Studio installation directory is
C:\WebSphere\CommerceStudio55, which may appear as
C:\WEBSP~I\COMMER™1 when part of a path in the Path environment
variable.

Remove the following directories:
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e WCStudio installdir where the default value for WCStudio_installdir is
listed in [“Path variables” on page v.|

* The WebSphere Commerce Studio workspace directory. The default
workspace directory is C:\WebSphere\workspace_db2 or
C:\WebSphere\workspace_oracle, depending on the target database type
you chose in the WebSphere Commerce Studio installation wizard.

If you receive a sharing violation error when removing the following
directories, try stopping all DB2 Universal Database processes before
trying to remove the directories again.

Uninstalling WebSphere Studio Application Developer

Before uninstalling WebSphere Studio Application Developer, uninstall

WebSphere Commerce Studio by following the instructions in
[WebSphere Commerce Studio” on page 99|

To uninstall WebSphere Studio Application Developer, complete the following
steps:

1. While logged on with a Windows user ID with Administrator authority,
select Start » Settings » Control Panel »+ Add/Remove Programs.

2. Click Change or Remove Programs, select IBM WebSphere Studio
Application Developer and click Remove.

3. A window opens asking you to confirm that you want to remove the
selected programs. Click Yes to continue with the uninstall.

4. When the uninstall is complete, restart your machine.
5. Delete the following directories:
* WSAD_installdir

where the default value for WSAD_installdir is listed in [‘Path variables’|

Uninstalling DB2 Universal Database

Before uninstalling DB2 Universal Database, uninstall WebSphere Commerce
Studio by following the instructions in [“Uninstalling WebSphere Commerce|
[Studio” on page 99.|

To uninstall DB2 Universal Database complete the following steps:

1. Drop your WebSphere Commerce Studio database. To drop the database,
do the following:

a. Start a DB2 command line session by selecting Start + Program Files -
IBM DB2 » Command Line Tools »* Command Window.
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b. Check the name of the WebSphere Commerce Studio database by
issuing the following command in the DB2 command line session:

list db directory

This command lists all databases defined.
c. Issue the following command:
drop db db_name

where db_name is the name of your WebSphere Commerce Studio
database.

. Select Start » Settings + Control Panel + Add/Remove Programs.

. Click Change or Remove Programs, select DB2 Universal Database and
click Remove.

. A confirmation window opens asking you to confirm the uninstall. Click
Yes.

. The Setup window opens, asking you if you want to modify, repair or
remove the program. Select Remove and click Next to continue with the
uninstall.

. A confirmation window opens asking you to confirm the uninstall. Click
Yes.

. When the uninstall is completed, click Finish.
. Delete the following directories:

* DBZ installdir

* drive:\DB2

where the default value for DB2_installdir is listed in [“Path variables” on|

. Restart your machine.
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Appendix E. Where to find more information

More information about the WebSphere Commerce Studio system and its
components is available from a variety of sources in different formats. The
following sections indicate what information is available and how to access it.

WebSphere Commerce Studio information

The following are the sources of WebSphere Commerce Studio information:
* [“WebSphere Commerce Studio online help”|

* ["WebSphere Commerce Web site” on page 104

* ["WebSphere Developer Domain” on page 104|

* ['IBM Redbooks "~ on page 104

WebSphere Commerce Studio online help

The WebSphere Commerce Studio online information is your primary source

of information for creating and publishing stores in WebSphere Commerce
Studio.

To view the WebSphere Commerce Studio online help, do the following;:

1. Start WebSphere Commerce Studio by selecting Start » Programs » IBM

WebSphere Commerce Studio + WebSphere Commerce development
environment.

2. From the Help menu, select Help Contents.

Note: If you refer to instructions for multiple platforms in the|“WebSphere

[Commerce Studio online help,”| ensure you follow the instructions for
WebSphere Commerce Studio. When a help page contains information
for multiple platforms, information specific to WebSphere Commerce
Studio is indicated with the following icon:

Developer

If information specific to WebSphere Commerce Studio is not available,
ensure you follow instructions specific to Windows, When a help page
contains instructions for multiple platforms, instructions for Windows
are indicated with the following icon:
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WebSphere Commerce Web site

WebSphere Commerce Studio product information is available at the
WebSphere Commerce Web site. Refer to the following URLs for more product
information:

[http://www.ibm.com/software/webservers/commerce/1ibrary/|

WebSphere Developer Domain

Additional information on WebSphere Commerce Studio and WebSphere
Commerce is also available in the WebSphere Commerce Zone at WebSphere
Developer Domain:

[nttp://www.ibm.com/websphere/developer/zones/commerce/|

IBM Redbooks™

WebSphere Commerce Studio and WebSphere Commerce information is
available at the IBM Redbooks Web site:

|http://www.ibm.com/redbooks|

WebSphere Studio Application Developer information

The following are sources of information for WebSphere Studio Application
Developer:

* ["WebSphere Studio Application Developer online help”|

* ["WebSphere Studio Application Developer Web site”|

* ["WebSphere Developer Domain” on page 105|
* ["IBM Redbooks” on page 105

WebSphere Studio Application Developer online help

The WebSphere Studio Application Developer online help is your primary
source of information on how to perform tasks within WebSphere Studio
Application Developer.

To view the WebSphere Studio Application Developer online help, do the
following:

1. Start WebSphere Commerce Studio by selecting Start » Programs » IBM
WebSphere Studio » Application Developer 5.0.

2. From the Help menu, select Help Contents.

WebSphere Studio Application Developer Web site

WebSphere Studio Application Developer product information is available on
the WebSphere Studio Application Developer Web site:

|nttp://www.ibm.com/software/ad/studioappdev/1ibrary/|
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WebSphere Developer Domain
Additional information on WebSphere Studio Application Developer is
available on the WebSphere Studio Application Developer page of the
WebSphere Studio Zone of WebSphere Developer Domain:

[http://www.ibm.com/websphere/developer/zones/studio/appdev/|

IBM Redbooks

WebSphere Studio Application Developer information is available at the IBM
Redbooks Web site:

[http://www.ibm.com/redbooks|
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Notices

This information was developed for products and services offered in the
US.A.

IBM may not offer the products, services, or features discussed in this
document in other countries. Consult your local IBM representative for
information on the products and services currently available in your area. Any
reference to an IBM product, program, or service is not intended to state or
imply that only that IBM product, program, or service may be used. Any
functionally equivalent product, program, or service that does not infringe
any IBM intellectual property right may be used instead. However, it is the
user’s responsibility to evaluate and verify the operation of any non-IBM
product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give
you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the
IBM Intellectual Property Department in your country or send inquiries, in
writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY
OR FITNESS FOR A PARTICULAR PURPOSE.
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Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will
be incorporated in new editions of the publication. IBM may make
improvements and/or changes in the product(s) and/or the program(s)
described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those
Web sites. The materials at those Web sites are not part of the materials for
this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the
purpose of enabling: (i) the exchange of information between independently
created programs and other programs (including this one) and (ii) the mutual
use of the information which has been exchanged, should contact:

IBM Canada Ltd.

Office of the Lab Director
8200 Warden Avenue
Markham, Ontario

L6G 1C7

Canada

Such information may be available, subject to appropriate terms and
conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer
Agreement, IBM International Program License Agreement or any equivalent
agreement between us.

Trademarks

The IBM logo and the following terms are trademarks or registered
trademarks of International Business Machines Corporation in the United
States or other countries or both:

AIX CrossWorlds DB2
DB2 Universal Database IBM iSeries
MQSeries Redbooks WebSphere
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Solaris, Java and all Java-based trademarks and logos are trademarks or
registered trademarks of Sun Microsystems, Inc. in the United States, other
countries, or both.

Microsoft and Windows are trademarks or registered trademarks of Microsoft
Corporation in the United States, other countries, or both.

Pentium is a registered trademark of Intel Corporation in the United States,
other countries, or both.

Other company, product and service names may be trademarks or service
marks of others.
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